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AMX Limited Warranty and Disclaimer
This Limited Warranty and Disclaimer extends only to products purchased directly from AMX or an AMX Authorized Partner which include AMX Dealers, 
Distributors, VIP’s or other AMX authorized entity.

AMX warrants its products to be free of defects in material and workmanship under normal use for three (3) years from the date of purchase, with the fol-
lowing exceptions:

• Electroluminescent and LCD Control Panels are warranted for three (3) years, except for the display and touch overlay components are warranted 
for a period of one (1) year.

• Disk drive mechanisms, pan/tilt heads, power supplies, and MX Series products are warranted for a period of one (1) year.

• AMX lighting products are guaranteed to switch on and off any load that is properly connected to our lighting products, as long as the AMX lighting 
products are under warranty. AMX also guarantees the control of dimmable loads that are properly connected to our lighting products. The dimming 
performance or quality there of is not guaranteed, impart due to the random combinations of dimmers, lamps and ballasts or transformers.

• AMX software is warranted for a period of ninety (90) days.

• Batteries and incandescent lamps are not covered under the warranty.

• AMX AutoPatch Epica, Modula, Modula Series4, Modula CatPro Series and 8Y-3000 product models will be free of defects in materials and manu-
facture at the time of sale and will remain in good working order for a period of three (3) years following the date of the original sales invoice from 
AMX. The three-year warranty period will be extended to the life of the product (Limited Lifetime Warranty) if the warranty card is filled out by the 
dealer and/or end user and returned to AMX so that AMX receives it within thirty (30) days of the installation of equipment but no later than six (6) 
months from original AMX sales invoice date. The life of the product extends until five (5) years after AMX ceases manufacturing the product model. 
The Limited Lifetime Warranty applies to products in their original installation only. If a product is moved to a different installation, the Limited Lifetime 
Warranty will no longer apply, and the product warranty will instead be the three (3) year Limited Warranty.

All products returned to AMX require a Return Material Authorization (RMA) number. The RMA number is obtained from the AMX RMA Department. The 
RMA number must be clearly marked on the outside of each box. The RMA is valid for a 30-day period. After the 30-day period the RMA will be canceled. 
Any shipments received not consistent with the RMA, or after the RMA is canceled, will be refused. AMX is not responsible for products returned without 
a valid RMA number.

AMX is not liable for any damages caused by its products or for the failure of its products to perform. This includes any lost profits, lost savings, incidental 
damages, or consequential damages. AMX is not liable for any claim made by a third party or by an AMX Authorized Partner for a third party.

This Limited Warranty does not apply to (a) any AMX product that has been modified, altered or repaired by an unauthorized agent or improperly trans-
ported, stored, installed, used, or maintained; (b) damage caused by acts of nature, including flood, erosion, or earthquake; (c) damage caused by a sus-
tained low or high voltage situation or by a low or high voltage disturbance, including brownouts, sags, spikes, or power outages; or (d) damage caused 
by war, vandalism, theft, depletion, or obsolescence.

This limitation of liability applies whether damages are sought, or a claim is made, under this warranty or as a tort claim (including negligence and strict 
product liability), a contract claim, or any other claim. This limitation of liability cannot be waived or amended by any person. This limitation of liability will 
be effective even if AMX or an authorized representative of AMX has been advised of the possibility of any such damages. This limitation of liability, how-
ever, will not apply to claims for personal injury.

Some states do not allow a limitation of how long an implied warranty last. Some states do not allow the limitation or exclusion of incidental or consequen-
tial damages for consumer products. In such states, the limitation or exclusion of the Limited Warranty may not apply. This Limited Warranty gives the 
owner specific legal rights. The owner may also have other rights that vary from state to state. The owner is advised to consult applicable state laws for 
full determination of rights.

EXCEPT AS EXPRESSLY SET FORTH IN THIS WARRANTY, AMX MAKES NO OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. AMX EXPRESSLY DISCLAIMS ALL WARRANTIES 
NOT STATED IN THIS LIMITED WARRANTY. ANY IMPLIED WARRANTIES THAT MAY BE IMPOSED BY LAW ARE LIMITED TO THE TERMS OF 
THIS LIMITED WARRANTY. EXCEPT AS OTHERWISE LIMITED BY APPLICABLE LAW, AMX RESERVES THE RIGHT TO MODIFY OR DISCON-
TINUE DESIGNS, SPECIFICATIONS, WARRANTIES, PRICES, AND POLICIES WITHOUT NOTICE.



IMPORTANT SAFETY INSTRUCTIONS!
    

1) READ these instructions.

2) KEEP these instructions.

3) HEED all warnings.

4) FOLLOW all instructions.

5) DO NOT use this apparatus near water.

6) CLEAN ONLY with dry cloth.

7) DO NOT block any ventilation openings. Install in accordance with the manufacturer's instructions.

8) DO NOT install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
9) DO NOT defeat the safety purpose of the polarized or grounding type plug. A polarized plug has two blades with one wider than the other. A

grounding type plug has two blades and a third grounding prong. The wider blade or the third prong are provided for your safety. If the
provided plug does not f it into your outlet, consult an electrician for replacement of the obsolete outlet.

10) PROTECT the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the point where they Escape
from the apparatus.

11) ONLY USE attachments/accessories specified by the manufacturer.

12) USE ONLY with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a cart is used, use
caution when moving the cart/apparatus combination to avoid injury from tip-over.

13) UNPLUG this apparatus during lightning storms or when unused for long periods of time.
14) REFER all servicing to qualif ied service personnel. Servicing is required when the apparatus has been damaged in any way, such as power-

supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or
moisture, does not operate normally, or has been dropped.

15) DO NOT expose this apparatus to dripping or splashing and ensure that no objects filled with liquids, such as vases, are placed on the
apparatus.

16) To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord plug from the AC receptacle.

17) Where the mains plug or an appliance coupler is used as the disconnect device, the disconnect device shall remain readily operable. 

18) DO NOT overload wall outlets or extension cords beyond their rated capacity as this can cause electric shock or fire. 

The exclamation point, within an equilateral triangle, is intended to alert the user to the presence of important operating and maintenance 
(servicing) instructions in the literature accompanying the product.

The lightning flash with arrowhead symbol within an equilateral triangle is intended to alert the user to the presence of uninsulated "dangerous 
voltage" within the product's enclosure that may be of sufficient magnitude to constitute a risk of electrical shock to persons.

ESD Warning: The icon to the left indicates text regarding potential danger associated with the discharge of static electricity from an outside 
source (such as human hands) into an integrated circuit, often resulting in damage to the circuit.

WARNING: To reduce the risk of fire or electrical shock, do not expose this apparatus to rain or moisture.

WARNING: No naked flame sources - such as candles - should be placed on the product.

WARNING: Equipment shall be connected to a MAINS socket outlet with a protective earthing connection.

Caution: To reduce the risk of electric shock, grounding of the center pin of this plug must be maintained. 

WARNING: 

This product is intended to be operated ONLY from the voltages listed on the back panel or the recommended, or included, power supply of the 
product. Operation from other voltages other than those indicated may cause irreversible damage to the product and void the products 
warranty. The use of AC Plug Adapters is cautioned because it can allow the product to be plugged into voltages in which the product was not 
designed to operate. If the product is equipped with a detachable power cord, use only the type provided with your product or by your local 
distributor and/or retailer. If you are unsure of the correct operational voltage, please contact your local distributor and/or retailer.



ESD WARNING 

 

FCC AND CANADA EMC COMPLIANCE INFORMATION:
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1)   This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following measures:

•Reorient or relocate the receiving antenna.
•Increase the separation between the equipment and receiver.
•Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
•Consult the dealer or an experienced radio/TV technician for help.

Approved under the verif ication provision of FCC Part 15 as a Class B Digital Device.
Caution: Changes or modifications not expressly approved by the manufacturer could void the user's authority to operate this device.
This Class B digital apparatus complies with Canadian ICES-003. 
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

EU COMPLIANCE INFORMATION:
Eligible to bear the CE mark; Conforms to European Union Low Voltage Directive 2006/95/EC; European Union EMC Directive 2004/108/EC; European 
Union Restriction of Hazardous Substances Recast (RoHS2) Directive 2011/65/EU, European Union WEEE (recast) Directive 2012/19/EU; European 
Union Registration, Evaluation, Authorization and Restriction of Chemicals (REACH) Directive 2006/121/EC.

You may obtain a free copy of the Declaration of Conformity by visiting http://www.amx.com/techcenter/certifications.asp

WEEE NOTICE

To avoid ESD (Electrostatic Discharge) damage to sensitive components, make sure you are properly grounded before touching any
internal materials. 
When working with any equipment manufactured with electronic devices, proper ESD grounding procedures must be followed to make
sure people, products, and tools are as free of static charges as possible. Grounding straps, conductive smocks, and conductive work
mats are specifically designed for this purpose.
Anyone performing field maintenance on AMX equipment should use an appropriate ESD field service kit complete with at least a
dissipative 
work mat with a ground cord and a UL listed adjustable wrist strap with another ground cord

WARNING: Do Not Open! Risk of Electrical Shock. Voltages in this equipment are hazardous
to life. No user-serviceable parts inside. Refer all servicing to qualified service personnel. 
Place the equipment near a main power supply outlet and make sure that you can easily
access the power breaker switch.

This appliance is labeled in accordance with European Directive 2002/96/EC concerning
waste of electrical and electronic equipment (WEEE). This label indicates that this product
should not be disposed of with household waste. It should be deposited at an appropriate
facility to enable recovery and recycling. 
ii Administrators Guide - NMX-MM-1000 Enzo Meeting Presentation System
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Overview
Overview
Vision2 is a sophisticated, fully-integrated video capture, management, and broadcast system for organizations and homeowners 
wanting a comprehensive, yet simple-to-use, IP video delivery solution. Vision2 offers live, scheduled, or on-demand video, all 
managed from a convenient web interface. Through the web interface, you can perform the following:

Capture and encode content
Upload, archive, manage, and publish content
Schedule programming 
Broadcast at selectable bitrate to any platform
Provide live TV and video on-demand over Intranet to PCs and Set-top boxes attached to displays
Provide video on-demand to supported tablets

Live Channels
Vision2 services output one or more multicast video streams, called Live Channels, which can be viewed by PC or Set-top box users. 
Live Channels are managed by Vision2 and so they are referred to as managed channels. If using a third party multicast video 
stream source, it can be added to Vision2 as an unmanaged channel. Unmanaged refers to the fact that Vision2 does not control the 
channel. Unmanaged channels also appear in the list of Live Channels available to PC and Set top box users.

Vision2 Services
Vision2 consists of a number services which correspond to the main video functions. See the table below for a description of each 
service. 

Components of a Vision2 system
A Vision2 system can consist of one or more Vision2 servers. One of the Vision2 servers must be set as the master server, the other 
servers known as slaves are subordinate to this server. Typically a V2-MASTER-xxxx server is used as the Master server but it is 
possible to use other servers as the master server in smaller installations. User access the Vision2 user interface through a web 
page on the master server,
http://<master server name>/v2.aspx. Tablet users connect to http://<master server name>/tablet.aspx

Similarly set-top boxes connect to the master server using the url http://<master server name>/v2.aspx.

The following table lists the different Vision2 servers:

Vision2 Services
Service Description

Archive Video archive used for viewing videos on demand

DVB Add Digital Tuner channels to your Vision2 system

Record Record any of the channels in your system to a selected Archive

Producer Create a scheduled TV channel using video stored in your archives

Reflector Transmit your Vision2 channels over the Internet or onto another subnet

MAX CSE Encoder Use a MAX CSE encoder to add an analogue video source to your Vision2 system

Vision2 Server
Name FG number Description

V2-MASTER-0300 FG3106-03
V2-MASTER-1200 FG3106-12
V2-MASTER-1210 FG3107-12K
V2-MASTER-1210 FG3107-12
V2-MASTER-2400 FG3106-24
V2-MASTER-3600 FG3106-36 

FG3106-03K 1.8 TB 
FG3106-12K 9.1 TB 
FG3107-12K 12 TB
FG3107-12 12 TB
FG3106-24K 18.2 TB 
FG3106-36K 27.3 TB 

Hosts VOD Archive, Reflector, Producer, and Record Services. 
There can be only one Master Server per Vision2 installation, 
however the same hardware can be used as a Slave Server. Access 
point for Vision2 user interface. The V2-MASTER is available with 
different amounts of archive storage (Note the storage amounts 
quoted in TB are the amounts available for use by all Archives on 
the system, not the hard drive space).
1Vision2 Instruction Manual
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Format Compatibility
The following tables list the formats that are compatible with Live channels and Video on Demand.  

* - Some Windows 7 Media Players support MP4.

Server Specif ications
The following table lists the specifications for the V2-SERVER-0300 (FG3106-03), V2-SERVER-1200 (FG3106-12), V2-SERVER-
2400 (FG3106-24), V2-SERVER-3600 (FG3106-36), V2-Server 1210 (FG3107-12K and FG3107-12) servers:

Live Channel Compatibility Amino VLC PC Client WMP Tablet Enzo
WMV No No Yes Yes No No

MPEG-2/MPEG-2 TS Yes Yes Yes Yes No Yes

H.264 (AVC)/MPEG-2 TS Yes Yes No No No Yes

H.264 (AVC)/MP4 Yes Yes No No No Yes

Video on Demand Compatibility Amino VLC PC Client WMP Tablet Enzo
WMV No Yes Yes Yes No No

MPEG-2/MPEG-2 TS Yes Yes Yes Yes No Yes

H.264 (AVC)/MPEG-2 TS Yes Yes Yes Yes No Yes

H.264 (AVC)/MP4 No Yes Yes No* Yes Yes

FLV (On2 VP6/FLV) No Yes Yes Yes No No

MP3 Yes Yes Yes Yes Yes Yes

V2-SERVER Specif ications
Processor: • 2 x Intel® Xeon® E5-2620, 2.00 GHz processors

• 2 x Intel® Xeon® E5-2620 v3, 2.40 GHz processors (FG3107-12/12K only)

Memory: • 16GB RAM
• 32GB RAM (FG3107-12/12K Only)

Storage (available): • 1.8 TB (7.2K RPM) (V2-SERVER-0300, FG3106-03)
• 9.1 TB (7.2K RPM) (V2-SERVER-1200, FG3106-12)
• 12 TB (7.2K RPM) (V2-SERVER-1210, FG3107-12 /12K)a

• 18.2 TB (7.2K RPM) (V2-SERVER-2400, FG3106-24)
• 27.3 TB (7.2K RPM) (V2-SERVER-3600, FG3106-36)

a. This is the physical capacity. Actual available storage space will be less due to the RAID configuration of the disks.

Power: 1100W (100-240 VAC), 47/63 Hz
Note: You can add one additional power supply (V2-POWER-1100) to your server to provide 
power supply redundancy.

Front Panel Components:

USB ports • 2 USB 2.0 ports for mouse, keyboard, or external peripherals
• 1 USB 2.0 ports for mouse, keyboard, or external peripherals (FG3107-12/12K)

Video connector 1 15-pin (female) video connector for connecting a video output device such as a PC monitor

Power button Press to power on server.

Rear Panel Components:

Video connector 2 15-pin (female) video connectors for connecting a video output device such as a PC monitor

Serial connector 1 9-pin (male) serial connector

USB port • 3 USB 2.0 ports for mouse, keyboard, or external peripherals
• 2 USB 2.0 ports on FG3107-12/12K only

LAN connectors 4 RJ-45 LAN ports for connecting to a network router (10/100/1000 Ethernet)

Rack Mount Sliding Ready™ rails with Cable Management arm

Operating Environment: • Operating Temperature: 10º C to 35º C (50º F to 95º F)
• Storage Temperature: -40º C to 65º C (-40º F to 149º F)
• Operating Relative Humidity (non-condensing twmax=29º C): 10% to 80% non-condensing
• Maximum Humidity Gradient: 10% per hour, operational and non-operational 
• Storage Relative Humidity: 5% to 95% non-condensing (twmax=38º C)
• Heat Dissipation: 4100 BTU/hr max

Dimensions (HWD): 3 7/16" (8.73cm) H x 19" (48.24cm) W x 30" (75.5cm) D

Weight: 71.5 lbs (32.5 kg)

Certifications: CE, NRTL, FCC Class A
2Vision2 Instruction Manual
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Vision2 Expansion Storage
The Vision2 Expansion Storage V2-STORAGE-2400 (FG3102-01) is an optional accessory that connects directly to your Master 
server to allow you to grow the storage capacity of your system. The Expansion Storage is shipped in a RAID configuration in order 
to provide resiliency in the event of a disk failure.
The following table lists the specifications for the V2-STORAGE-2400 Expansion Storage (FG3102-01):

Please note that the V2-STORAGE-2400 is only compatible with a V2-MASTER Vision² Master Server (FG3106-XXK) which has a 
V2-STORAGE-EXT810 Vision2 External RAID Controller (FG3102-03) installed.

V2-DISK-1210, 12 TB EXPANSION DISK KIT 
The V2-DISK-1210 Expansion Disk Kit (FG3107-12D)allows users to add additional storage to the V2-MASTER-1210 Vision2 
Master Server or the V2-SERVER-1210 Vision2 Expansion Server. It includes three 4 TB disks, for a total physical capacity of 12 TB. 
Each Vision2 server has twelve disk bays and comes pre-populated with three 4 TB disks. Up to three Expansion Disks Kits can be 
added to a Vision2 server, for a total installed capacity of 12 disks and 48 TB of raw storage. The disks in a Vision2 server are in a 
RAID configuration, so the total available capacity for video content will be less. 
The V2-DISK-1210 Expansion Disk Kit can be either field or factory installed. When installed in the field, the server will have to 
through a RAID expansion process, which could leave the server unavailable for a period of several hours.
Please note that the V2-DISK-1210 is only compatible with one of the following: 

V2-MASTER-1210 Vision² Master Server (FG3107-12K) 
V2-SERVER-1210 (FG3107-12)

V2-STORAGE-2400 Expansion Storage Specif ications
Storage: 12 2TB 7.2K RPM NL SAS 6Gbps 3.5in HotPlug Hard Drives

Power: • 488W maximum continuous; 550W peak
• 90-264V
• 47-63 Hz
• 7.2A at 100V, 3.6A at 200V

Rear Panel Components:

Output ports 2 SAS connectors for connection to a Master server

Expansion ports 2 SAS connectors for expansion to an additional V2 Expansion storage unit

Operating Environment: • Operating Temperature: 10º to 35º C (50º to 95º F)
• Storage Temperature: -40º to 65º C (-40º to 149º F)
• Operating Relative Humidity: 8% to 85% (non-condensing)
• Storage Relative Humidity: 5% to 95% (non-condensing)
• 1181 BTU per hour

Dimensions (HWD): 3 7/16" (8.7 cm) H x 19" (48.2 cm) W x 23 3/8" (59.4 cm) D

Weight: 62.6 lbs (28.39 kg)

V2-DISC-1210 Expansion Disk Specif ications
Number of Disks: • 3

Disk Type: • 7.2K RPM near-line SAS

Disk Capacity • 4TB per disc 
3Vision2 Instruction Manual
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STB-04 Set-Top Box
The following table lists the specifications for the STB-04 Set-Top Box (FG3100-65):

NOTE: STB devices that send an "offline" status to Vision2 will appear as offline in the STB table and the icon will turn gray.

Vision2 Network Switch Requirements
Vision2 requires a Gigabit layer 2/3 network switch with IGMP Snooping/Querier support. The network switch should meet the 
following requirements:

STB-04 Set-Top Box Specif ications
Memory: 128MB Flash, 256MB RAM

Power: • 5V DC at 1.5A via external power supply
• Less than 8W typical usage (external supply input voltage 100-240V AC 

50-60Hz 3A max)

Front Panel LED: Power on/IR command received (Red)

Rear Panel Components:

Power connector 1 connector port for a 5V DC at 3A power supply

LAN ports 1 x Ethernet 10/100 BaseT via RJ-45 shielded connector

USB port 1 Type-A USB 2.0 port for peripheral connections

HDMI port 1 HDMI 1.3a with HDCP and CEC port

SPDIF port 1 S/PDIF(optical) port

AUDIO VISUAL port 1 10-way Mini-DIN for Composite video, Component (YPrPb), RGB, S-Video, and 
analog audio

IOIOIO port 1 IR extender and TVI port

Codecs: • MPEG-2 MP@HL
• MPEG-4 pt10 AVC/H.264 HP@L4

Video Resolution: Up to 720p and 1080i. The video output resolution on the STB should be set to 
720p.

Graphics Resolution: HD graphics up to 1280x720

Audio: • Analog stereo audio out
• Stereo and Dolby 5.1 surround via S/PDIF and HDMI
• Dolby Digital+ pass through to external decoder

Operating Environment: • Operating Temperature: 0º to 40º C (32º to 104º F)
• Storage Relative Humidity: 5% to 95% (non-condensing)

Dimensions (HWD): 1 9/16" (4cm) H x 5 1/2" (14cm) W x 4 1/2" (11.4cm) D

Weight: 0.70 lbs (0.32 kg)

Included Accessories: • 1 Amino Universal Remote Control

Network Switch Requirements
Physical Interfaces: RJ-45 connectors for 10Base-T, 100Base-TX, 1000Base-T with 8, 16, 24, or 48 

ports.

Layer 2 Services: • IGMP Snooping V1 or V2 (Not router dependent for operation)
• IGMP Querier
• Layer 2/3 switching
• Spanning Tree Protocol (STP)

Security: • QoS
• Storm Control Broadcast and Multicast

Performance Specifications: Jumbo frame support

Switching Capacity: Non Blocking 32Gbps (16Port) - 140Gbps (48Port)

Forward Rate: 24Mpps (16Port) - 96Mpps (48Port)

Internet Protocol: IPv4 or IPv6

Optional: • VLAN support
• Web User Interface
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Overview
Using Vision2 without a DNS Server
Using Vision2 with a DNS Server is recommended. If a DNS Server is not available, the hosts file will need to be edited on each 
Vision2 server and the names and IP addresses of all your Vision2 servers added. The hosts file is located in the folder 
C:\windows\system32\drivers\etc. 
FIG. 1 shows a hosts file for a setup with one master server called V2MASTER with IP address 192.168.20.110 and one Digital TV 
Appliance called V2DVBGATEWAY with IP address 192.168.20.111.  

CAUTION:  If a DNS server is not available and the name of a server needs to be changed, you will have to update the name of the 
server in the host f ile on each of the servers which make up the Vision2 system.

FIG. 1  Example Hosts File
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Wiring and Device Connections
V2-Master Server Rear Panel Connections
This section details the ports and connectors on the rear panel of the Vision2 Master server (FIG. 2). 

The two flex drives at the rear of the V2-Master server are fitted with 146GB 15K SAS 2.5in Hot-Plug Drives configured as Raid1 for 
the OS (Microsoft Windows Server 2008 Standard) 

LAN (RJ-45) Port

FIG. 4 describes the blink activity for the LAN 10/100/1000 Base-T RJ-45 connector and cable.

NOTE: Vision2 uses typical Cat5/5e/6 cabling for RJ-45 connections.

The following table lists the pinouts, signals, and pairing associated with the LAN connector.  

FIG. 2  Vision2 Master Server Rear Panel

FIG. 3  LAN (RJ-45) Port

FIG. 4  LAN Connector / LEDs

LAN RJ-45 Pinouts and Signals
Pin Signals Connections Pairing Color

1 TX + 1 --------- 1 1 --------- 2 Orange-White

2 TX - 2 --------- 2 Orange

3 RX + 3 --------- 3 3 --------- 6 Green-White

4 no connection 4 --------- 4 Blue

5 no connection 5 --------- 5 4 --------- 5 Blue-White

6 RX - 6 --------- 6 Green

7 no connection 7 --------- 7 7 --------- 8 Brown-White

8 no connection 8 --------- 8 Brown

Output port

LAN ports

Power connector

ETHERNET

A L
A - Activity LED (yellow)
lights when receiving or

transmitting LAN
data packets

L - Link LED (green) lights when
the LAN cables are connected
and terminated correctly. 
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Wiring and Device Connections
FIG. 5 diagrams the RJ-45 pin-outs and signals for the LAN RJ-45 connector and cable.     

Set-Top Box Connections
The STB-04 Set-Top Box (FG3100-65) supports viewing the Live Channels from MAX CSE Encoders, Producers, Reflectors, or DVB 
Tuners. The set-top boxes access the Vision2 server and display available programming on a connected video source. The set-top 
boxes are used only for MPEG 2 content. They support viewing MPEG Video on Demand Stop, Play, and Pause, Fast Forward and 
Rewind features.

NOTE: The Set-Top Boxes support video up to a resolution of 720p or 1080i. Sending video with greater resolution could cause the 
set-top boxes to reset themselves periodically.

FIG. 6 displays the rear panel of the STB-04 Set-Top box.

FIG. 5  RJ-45 Wiring Diagram

FIG. 6  STB-04 Set-Top Box (rear-view)

USB portSPDIF
port

LAN
port

Power

HDMI port

Audio/Video port

IR Extender/TVI port
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Installation
This section provides instructions on how to install the different Vision2 accessories.

Installing Master Server Accessories
Optional accessories can be installed in the Master server for redundant power or for connection to an Archive server.

Installing a Secondary Power Supply
The V2-POWER-1100 (FG3106-PS) is a secondary power supply that can be used to add redundant power to FG3106-XX and 
FG3107-XX Vision2 Master Servers. Master servers ship with a single 1100W power supply. One additional V2-POWER-1100 can be 
added to the server to provide power supply redundancy.

NOTE: The V2-POWER-1100 power supply is only compatible with the FG3106-XX and FG3107-12/12K Vision2 Master servers.

Follow these steps to install a secondary power supply.
1. Remove the metal cover from the power supply expansion slot (see FIG. 8).

2. Slide the secondary power supply into the slot until the orange tab beside the power connector clicks into place.

Installing Expansion Storage
The following steps describe how to add an additional 24TB of Disk storage to an existing archive server.
1. Connect an SAS cable to the IN port on the rear of the V2-STORAGE-2400 Expansion Storage device (FIG. 10). 
2. Connect the other end of the cable to the first SAS port on the rear of the Master server. 

Set-Top Boxes
The STB-04 (FG3100-65) Set-Top Box supports viewing live programming via a Producer channel, MPEG encoder, or DVB Tuner 
channel. The set-top boxes access the Vision2 server and display available programming on a connected video source. The set-top 
boxes are used only for MPEG2 and MP3 content. They support viewing MPEG Video on Demand, but support only Stop, Play, 
Pause, Fast Forward, and Rewind features.

FIG. 7  V2-POWER-1100 Power Supply

FIG. 8  Master Server Rear Panel

FIG. 9  Vision2 Archive/Video on Demand server with V2-PVA (rear-view)

FIG. 10  V2-STORAGE-2400 Expansion Storage (rear-view)

Remove metal cover
from expansion slot.
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Installation
Set-Top Boxes communicate with Vision2 by "calling home" every 5 seconds. During this call the Set-Top Box updates Vision2 on its 
status and picks up any messages waiting for it from Vision2. For example, if a user sends an RS232 serial request, that message 
will wait with Vision2, the Amino Set-Top Box will call home up to 5 seconds later, then will send the RS232 request to the 
connected device, and the Set-Top Box will update the status 5 seconds after that. Assuming there are no delays getting a response 
from the connected device, it will take 10 seconds for an RS232 request to reach a serial device connected to a Set-Top Box and 
confirm receipt.

NOTE: The Set-Top Boxes have a limit of 18Mbps. Heavy traff ic loads can cause the set-top box to reset itself periodically.

FIG. 11 displays the rear panel of the STB-04 Set-Top box.

NOTE: Do not use the reset button on the back of your set-top box.

Conf iguring the Set-Top Box
Before a set-top box can be used to view a video source, it must be configured to access the Vision2 server. Plug a USB keyboard 
into the USB port on the front of the set-top box.

NOTE:  The set-top-box will need to be power cycled to allow it to recognize the keyboard.

Perform these steps to configure the set-top box:
1. Connect the power supply to the power connector on the rear of the unit.
2. Choose one of the following methods to connect the set-top box to audio and video sources:

Use an HDMI cable to connect the HDMI port on the set-top box to an HDMI port on the video source. HDMI also transmits 
an audio signal in addition to video.

Use a breakout cable to connect the AUDIO VISUAL port on the set-top box to your audio and video sources. In place of 
connecting the breakout cable to your audio source, you can connect an optical audio cable from the SPDIF port on the 
set-top box to your audio source.

3. Connect an RJ-45 LAN cable to LAN port 1 on the rear of the unit. The other end of the cable connects to your LAN. This 
connection accesses your Vision2 server and can be used to upload the latest firmware and Vision2 menus to the set-top box.

Management Pages
Login to the management pages on your set-top box as follows:
1. Press Alt-M on the keyboard to access the Enter Management Pages login (FIG. 12).
2. In the Password text box, enter the password (the default is leaves) and press Enter. The Set-top box Management screen 

appears.

3. Check that your set-top box has the correct firmware and Opera browser installed (Opera 10 or Opera 11), using the arrow 
keys on the keyboard to access User Prefs and press the right arrow cursor key to enter this page.

4. You are prompted whether you want to enter the User Preferences page. Press enter and use the right/left cursor keys to 
change this setting to Yes.

FIG. 11  STB-04 Set-Top Box (rear-view)

FIG. 12  Enter Management Password (default password - leaves)
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Installation
5. Press enter again to confirm the new setting. The unit will prompt for the write password for modifying settings in the space 
provided (the default is snake). You will need to enter this password whenever you change settings.

6. A new set of menus should now be visible. Select the info menu and check the software version. Ensure that Opera 10 version 
2.34 or 2.5.2 (FIG. 13) or Opera 11 version 3.3.2a.20 is running.

NOTE: Opera 11 is now supported but units equipped with Opera 11 need to use a new Vision2 URL outlined in the "Browser 
Homepage" section below.  

7. Select the back option and return to the main menu.

Set-Top Box Networking
Setup networking on the set-top box as follows:
1. Select the DHCP menu.
2. Change the DHCP setting to disabled.
3. Enter an IP address, Netmask, Gateway and (optional) DNS server setting for the set top box.

Browser Homepage
Set the browser home page for your set-top box to point to a page on your Vision2 master server:
1. Use the arrow keys on the keyboard to access the Browser option, and press the right arrow cursor key to enter this page 

(FIG. 15).

FIG. 13  Software Version

FIG. 14  Network Settings

FIG. 15  Set-Top Box Browser Configuration
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Installation
2. Select the home page setting using the cursor keys and press the DEL key to start editing.
3. Delete any text using the backspace key and then enter the address of the Vision2 master server. If using a DNS server, enter 

the hostname of server, or enter the server’s IP address. The URL is different between units running Opera 10 and Opera 11. 
The URLs are as follows: 

Opera 10
http://<master server name>/aminoH140.aspx 

or if there is no DNS server 
http://<master server IP>/aminoH140.aspx

Opera 11
http://<master server name>/AminoH14016.aspx

or if there is no DNS server 
http://<master server IP>/AminoH14016.aspx

NOTE: The set-top box must be conf igured to point at the master server, not to any of the slave servers.

4. Press enter and another Password prompt appears. Enter the password for modifying settings in the space provided (the 
default is snake).

5. Set Full screen mode setting to Disabled, and GFX resolution to 720 HD.

Video Settings
Configure the video settings as follows:
1. Return to the User Prefs menu and select the Video page (FIG. 16).
2. Change the TV type setting to the correct aspect ratio for the attached display (e.g. 16:9).
3. Change the output resolution to 720p.
4. Select the back option and choose yes to return to the main menu.

Restart the set top box by selecting Restart followed by Yes and press Enter to reboot the set-top box.

CAUTION:  The Amino Set-Top Box must have both its GFX resolution and Output resolution set to 720p in order to ensure proper 
operation.

FIG. 16  Video Settings
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Using the Remote Control
The set-top box includes a universal remote control to control the video display and navigate through the Vision2 menus. Not all 
buttons on the remote work with your Vision2 setup. While Vision2 supports Video on Demand (VoD), you can use only the Play, 
Pause, Stop, Fast-Forward, and Rewind features. FIG. 17 highlights some of the buttons you can use with Vision2 and your set-top 
box. 

NOTE: Subtitles are only supported on DTV streams.

NOTE: If using an STB-04 set-top box and you receive a "failed to load webpage" error, select the OK button on the remote and, using 
the remote, power the set-top box off and on again. Afterward, the Vision2 main menu loads.

After the set-top box reboots, it accesses the specified Vision2 master server and downloads the latest Vision2 menus.

NOTE: Ensure whether the set top box has Opera 10 or Opera 11 installed.

The Vision2 menus can be accessed by pressing the Menu button on the remote control. The Vision2 Main Menu (FIG. 18) contains 
two options discussed in detail in the following sections: Live TV Feeds and Video on Demand.

FIG. 17  Amino Remote Control

FIG. 18  Vision2 Main Menu

Volume control

Play Pause

Stop

Power

Navigational buttons for 

Vision2 menus

Menu button for accessing
the Vision2 menu

Turn on Subtitles

manuvering through the
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Live TV Feeds
The Live TV Feeds menu (FIG. 19) displays a listing of all Live Channels available in the Vision2 system. Use the remote control to 
scroll through the channels and press OK on the remote control to select and view a channel. See the Using the Remote 
Control section on page 12 for more information on using the remote.

Video on Demand
The Video on Demand menu displays a listing of all available video archives (FIG. 20).

Use the remote control to scroll through the list of archives and press OK to enter an archive. Within an archive will be a number of 
categories. Use the cursor keys on the remote to navigate to and highlight the desired category. Click OK to navigate into the 
category. 
Use the same method to select a video/audio file within a folder. Select a Video (FIG. 21) and click OK to view the video thumbnail 
fullscreen along with any metadata associated with the video (FIG. 22). Click OK again to play the video. See the Using the Remote 
Control section on page 12 for more information.   

FIG. 19  Live TV Channels

FIG. 20  Video On Demand Section - List of Archives

FIG. 21  Selecting a Video to Play
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FIG. 23 displays an example of video on demand programming. While viewing video on demand programming, you can use the 
remote control to pause or stop the video stream. If you press OK on the remote control while a video is playing then a seek bar 
appears. Press Left or Right on the control while the seek bar is displayed to move to the correct location in the video and then press 
OK again to resume playback. 

Use the Play button to resume viewing a paused video stream. To refresh your set top box to display new content in your archive or 
to refresh the template displayed, navigate away from the main menu into the Live Channels or Video on Demand pages and press 
and hold the menu button for a second or more. The screen should flash and will return to the main menu. The set-top box will 
refresh and the new template and new Archive content can be viewed.
The set-top box also has a search feature, select the search icon and click OK to open the search dialogue box, see FIG. 24. Enter 
the text you want to search for and click GO, this returns any matching videos. Note that the search is case-insensitive.

FIG. 22  Video Metadata

FIG. 23  Video Playback and Seek Bar

FIG. 24  Search Feature
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Vision2 User Interface
This section provides a brief overview of the Vision2 User interface under the following headings:

Vision2 User Interface Requirements - Software and plugins needed to use Vision2
Accessing the Vision2 User Interface - Explains how to access the Vision2 User interface
Vision2 Menu Structure
Access Control
Loading and Enabling Vision2 Services

Vision2 User Interface Requirements
PC Users who wish to connect to Vision2 must be aware that the interface has the following requirements:

You must use Internet Explorer 9 32 bit. Note if you install IE9 64 bit on a 64 bit operating system then it will also install the 
32 bit version. Create a shortcut to this version of Internet Explorer to use with Vision2. Vision2 only supports 32 bit 
browsers.

Configure Internet Explorer to check for newer versions of stored pages every time a web page is visited as follows:
Press Alt+X and select Internet options
Choose the settings option under Browsing History, and select every time I visit the webpage.

VLC version 2.0.5 and the VLC Active X plugin must be installed to view Video on Demand and Live Channels. Later versions 
of VLC are not guaranteed to work. When you first use Internet Explorer after installing the VLC plugin, the VLC add-on will 
need to be allowed to work.

NOTE:  If a version of VLC is already installed on your PC, VLC must be un-installed before continuing. 

Install VLC version 2.0.5 as follows:
1. Go to http://download.videolan.org/pub/videolan/vlc/2.0.5 and select the appropriate version for your operating system.
2. Run the installer and accept all the options until you reach the choose components screen, see FIG. 25. Make sure you select 

the Active X plugin and Mozilla plugin options. 

3. Click Next to continue.
4. Click Install to start the installation.
5. Vision2 is now ready to use on this PC.

NOTE:  VLC version 2.0.6 is not supported 

Accessing the Vision2 User Interface For the First Time
Perform these steps to access your Master Server for the first time:
1. Power on your Vision2 server. It may take a few minutes to boot.
2. Test that you can access the server via the LAN. You can run this test by accessing a Command Prompt using the Ping 

command. For example:
   ping v2AMX-xxxxxxxx

where v2AMX-xxxxxxxx is the master server name

FIG. 25  Install Active X and Mozilla plugins
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Vision2 User Interface
3. Using IE9 32bit, navigate to http://v2AMX-xxxxxxxx/v2.aspx. The Vision2 login page appears (FIG. 26).

4. Enter username and password. The Vision2 system has one administrator account. The default username and password are:
Username - Administrator
Password - Vision2

NOTE: AMX recommends changing the default password. Connect via remote desktop to the Vision2 master server and change the 
password for the Administrator user account.

5. The first time logging into a machine, the Vision2 interface will prompt you to make this server the master server. 

NOTE: Only one master server can be conf igured in a system.

6. Only access the Vision2 interface by connecting to the web application on the master server. Click OK to convert this server to 
a master server (FIG. 27).

7. Follow the prompt to reboot the server.
8. Optional - add more servers to the system if required. See the Manage System  on page 28.
9. License the server. See the Licensing  on page 22.

NOTE: The server must be rebooted after converting it to a master server or the server will be unable to be licensed.

Vision2 Menu Structure
The Vision2 menu has the following components:

FIG. 26  Login Screen

FIG. 27  Prompt to Convert Server to Master Server

Menu Structure
Menus Sub Menus Description

Archives Recent Updates See the 100 most recent updates in each archive

Browse Play Video on Demand
Upload Videos
Manage Videos

Configure Archive (Administrator only) Setup Archive

Archive Permissions (Administrator only) Used to determine which users can carry 
out which operations in the different folders which make up 
your Archives

Download FTP client Use the FTP client to upload videos which are larger than 2GB
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Menu and Archive Access Restrictions
Menu access is restricted as follows:

Only an administrator has access to the Manage System menu. The administrator also has access to all operations in all 
Archive folders even if user access is enabled on an archive.

If access control is disabled in the v2 services permissions screen, non administrator users have access to all menus and 
menu tabs except Live Channel > Order, Archive > Metadata, Archive > Permissions, and Manage System. 

If the administrator enables v2 services access control, non administrators are restricted to only those services that access 
has been granted to in the V2 Services Permissions screen along with the Archive > Recent Updates, Archive > Browse, and 
Live Channels > View screens

By default all users can carry out all operations in all Archive folders. To restrict access to an archive you must use the Archives > 
Permissions screen to enable access control.
To see Vision2 as a limited rights user:
1. Go to Manage System > User Access, check that User Access is set to NT User Groups.
2. Create a windows user account called testuser on the master server. Set testuser to be a member of the Users windows user 

group.
3. Set user password for testuser to test123.
4. Go to Manage System > V2 Services Permissions and Enable V2 Service User Access control. Access to all service pages 

(Reflector, Recorder, Producer, DVB tuner, and MAX CSE encoder) is now restricted to users with permissions set in this screen. 
As user bob has no permissions for these services, he has no access to these screens.

5. Login to the Vision2 user interface in a second browser tab by entering the standard URL, http://<master server name>/
v2.aspx and enter username=testuser and password=test123. You will now see the menus available to a user with the lowest 
level of access rights. Note that the user can only access Archives > Browse, Archives > Recent Updates, and Live Channels > 
View.

To allow a number of users to login, windows usergroups will need to be created on the master group for the different user types, 
and then create user accounts that belong to these usergroups.

Live Channels View View Live Channels (managed channels) created by Vision2 
Services and unmanaged channels (multicast video streams 
from external devices)

Channel Order (Administrator only) Modify the order that Live Channels are 
shown to PC and Set top box users

Manage MAX CSE Manage MAX CSE Encoder to display an analogue video 
source as part 

Manage Digital
Tuner

Manage DTV tuner to display Digital TV channels as part of 
Live Channels screen

Manage MPEG Reflector Transmit or Receive Vision2 Live Channels over the Internet.

Producers Manage Producer Create a Live Channel by scheduling a mixture of live feeds 
and Archive videos

Edit Schedule Edit Schedule for Producer Channel

Video Recorders Configure Recorder Configure a Record Service, choose which Live Channel to 
record and whether to do a manual, continuous or scheduled 
record

Manual Recording Start and Stop a Manual Record

Schedule Recording Edit Record Schedule

Manage System 
(Administrator Only)

Manage Servers Add/Remove servers to/from your Vision2 system

Manage Licensing Allocate/Remove Vision2 service licenses to/from your 
servers

View Logs View system and service logs

UI Configuration Determine background and look and feel for Set-top box and 
Tablet users

Manage STBs Play Video on Demand or Live Channels on set-top boxes 

User Access Use LDAP or Window NT groups for login authentication 
permissions

V2 Services Permissions Control access to Vision2 Services

VOD Bandwidth View bandwidth used for Video on Demand and Live Channels

Menu Structure
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View Live Channels
Vision2 Users can view all Live Channels configured in the system using the Live Channels > View Menu.
The available live channels are listed in the right hand column (FIG. 28). You can watch selected channels by clicking on the channel 
name.

Tablet Users
Vision2 has been tested on and supports the following tablets: 

iPad4 with iOS 6.1.3
Samsung Galaxy tab with Android V4.1.1
Motorola Zoom 1. 

Tablet users must use the following URL, http://<master server name>/tablet.aspx to access the Vision2 URL. Tablet users can 
only play MP3s or high bit-rate MPEG4 files. Tablet users only have access to Archive > Browsing.

NOTE: The tablet user interface uses a caching mechanism when browsing archive contents. To see new content, changes made by 
other users, and permissions changes the users must login again.

Loading and Enabling Vision2 Services
The typical steps the user must follow to load and enable Vision2 services are as follows:
1. Select a service (FIG. 29).
2. Click Load to load the service details. Once a service is loaded, a lock is gained on that service. This lock prevents any other 

users from modifying settings on this page and interfering with your work. 

3. Configure the service by changing the settings to the required values. The Apply button must be clicked in each section 
modified to save the changes. If Apply is not pressed, the changes will be lost.

FIG. 28  View Live Channels

FIG. 29  Select and Load a Service
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Vision2 User Interface
4. Enable the service by changing the Enable setting from Off to On (FIG. 30). In the majority of cases this will enable a multicast 
video stream which can be viewed in the Live Channels > View screen. A watch button will appear. Click it to jump directly to 
this screen.  

NOTE:  Once a service is enabled, its license cannot be removed from a server. 

Loading a Service and Service Locking
Load a service as follows:
1. Use the select a service drop down to find the service to load. This shows a list of all services of a particular type (in this case 

Record) in the Vision2 system which the current user has permissions for. The Service on Server label indicates which of the 
Vision2 servers hosts this service.

2. Click Load.
Once a service is loaded, this service is locked to your user account. This prevents two different users from modifying the same 
service at the same time. No other user can load this service until the user with the lock loads another service, navigates away from 
the screen or closes their browser. If another user tries to access the service, Vision2 will prevent access and tell them which user 
account has locked the service. Locks for all services except Record and Producer will be cleared after 20 minutes without activity. 
Record and Producer service locks are cleared after three hours without activity. These services have a longer timeout period to 
allow the user to set up schedules and to do long manual records.
If user has locked a service but has left their machine, then the administrator can release the lock using the following process:
1. Login as the Administrator. 
2. Select the appropriate menu tabs for the service. 
3. Select the locked service using the Select a Service drop down and click Load. The system responds that this service is 

currently locked and gives details of the user who has the lock.
4. Click manual unlocking to release the lock (FIG. 31). Any user can now access the service.

Renaming a Service. 
Vision2 service names are used throughout the application. In the case of Encoders, Reflectors, and Producers, the service name is 
used as the name of any Live Channel created by enabling the service. Rename a service as follows:
1. Select and load the service.
2. Change the text in the Service Name text box to the new name (FIG. 32).
3. Click Apply. 

FIG. 30  Enabling a Service

FIG. 31  Manually Unlocking a Locked Service

FIG. 32  Renaming a Service
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Server Management
This section provides information on managing multiple Vision2 servers. Small Vision2 systems will only have one server, the Master 
server. However larger installations will have two or more servers. In this case one server is configured as a Master server and the 
other servers are known as Slave servers as they are subordinate to the Master server. Vision2 services can run on any server but 
are controlled through the master server. The Vision2 user interface can only be accessed from the master server.

Adding a Server to the Vision2 System
To add a new server to the system, ensure that the machine is powered on and configured with the Vision2 Server application 
running. Before trying to add the new server to the Vision2 system, ensure that you can access the new server via the LAN. Perform 
these steps to add a server to your configuration:
1. Test access to the new server via the LAN by accessing a Command Prompt using the Ping command. For example:
    ping V2AMX-xxxxxxxx 

where V2AMX-xxxxxxxx is the slave server name. If the server responds, continue.
2. Using IE9 32bit on a PC with network access, navigate to http://<master server name>/v2.aspx. Login using the default 

administrator username and password (Administrator and Vision2 respectively).

NOTE: AMX recommends changing the default settings.

3. Select Manage System > Manage Servers using the menu system.
4. Enter the name of the new server in the Name text box belonging to the Add Server dialogue box.
5. Select the server type using the type drop down menu from the following options:

Slave Server - FG3106-XXK or FG3107-12 (for the FG3107-12K Master). This is the same hardware as the Master server 
but configured as a slave server to provide additional services including archives.

DVB Gateway - Not supported currently.
Reflector Gateway - Not supported currently.

6. Click Add to System to add the new sever to your Vision2 system (FIG. 33).
7. The system prompts to reboot the new server. This step must be performed or the new server will not function correctly and 

you will not be able to add Licenses to it.
8. Once the new server reboots, return to the Manage System > Manage Servers screen to see the new slave server. The status 

area indicates whether the server is offline or online (red or green circle). 

NOTE:  If an incorrect server name is entered the system will attempt the connection for a number of seconds and if unsuccessful the 
following error message will appear. The server on the address you entered is not responding. Please check the server name and 
network and try again.

Accessing a Vision2 Server Directly (Troubleshooting Only)
Perform these steps to access the server directly:
1. Connect a monitor to the VGA port on the front of the server.
2. Connect a USB keyboard and USB mouse to the 2 USB ports on the front of the server.

NOTE: There is also a 15-pin VGA port and 2 USB ports on the rear of the server. It makes no difference which set of ports used to 
connect peripherals.

3. Power "on" the Vision2 server. It may take a few minutes to boot.
4. Enter the username and password for the server. The default settings are:

username: Administrator
password: Vision2

FIG. 33  Adding a Slave Server to Vision2 System
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5. Check that following applications are running Vision2 Server and VLC Server. If they are not running, click the V2Server.exe 
icon on the desktop (FIG. 34). 

NOTE: The server can only be accessed using a remote desktop. Always use the Connect to Console option when using a Remote 
desktop application, otherwise you will not see the v2server application running. The remote desktop should be conf igured to leave 
sound at the remote computer. If the server is kept running continuously, it should always be accessible via its web address.

Changing a Server’s Name
The server’s name can be changed from the default name assigned to it. After changing the name, use the new server name to 
access the Vision2 application. Perform these steps to change the server’s name:
1. On the server’s desktop, close the Vision2 server application.
2. Click Start, right-click Computer, and select Properties. The System Properties window opens.
3. In the Computer name, domain and workgroup settings section, click Change settings to open the System Properties menu.
4. Click Change. The Computer Name Changes dialog box opens.
5. Enter the new name of the server in the Computer Name text box.
6. Click OK, and restart the server as requested. Next the new server name must be added to Windows Media Services.
7. Click Start, select Administrative Tools, and Open Windows Media Services. An RPC error box appears, click OK to bypass it.
8. In Windows Media Services, select Action from the top menu. Open Add Server, and enter the new server name and click OK.
9. Close the Windows Media Services window and reboot the server.

If DNS is not on the network, the appropriate entry in the hosts file will need to be changed on all of the Vision2 servers with the 
new name
 If this machine is a master server, perform the following extra steps:
1.  Login using the new servername as follows using Internet Explorer:
 http://<new servername>/v2.aspx

2.  The system prompts to reboot the server for a second time. Reboot all the slave servers as well.

If the machine is a slave server, perform the following extra steps:
1. Connect to the Vision2 user interface by entering the following in Internet Explorer, http://<master server name>/v2.aspx
2. Login as the administrator.
3. Go to Manage System > Manage Servers.
4. Click the Edit button for the Slave Server underneath Server Type and change the Server name. Click Apply when finished.

Removing a Slave Server
Remove a slave server as follows:
1. Connect to the Vision2 user interface by entering the following in IE9:
http://<master server name>/v2.aspx

2. Login as the administrator.
3. Select Manage System > Manage Servers from the Vision2 web interface.
4. Find the server to delete and click the Delete icon.

NOTE: This will lose access to any archives conf igured on the server. Note that the data is still present, contact AMX support to 
recover your data,

FIG. 34  Vision2 Server Desktop
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Licensing
This section explains how to License your Vision2 system and allocate Licenses to your Vision2 servers. There are three typical
steps to licensing a Vision2 system:
1. Obtain a License Entitlement ID for a Vision2 system from AMX.
2. Use the License Entitlement ID with the AMX License Manager on a Vision2 Master server or a local Network License manager 

to activate your license.

NOTE:  The license manager will show Vision2 8.2, but it applies to any 8.x versions.

3. Use the Vision2 License Management Screen Manage System > Manage Licensing within the Vision2 user interface to 
allocate the services contained in your AMX license entitlement to different Vision2 servers.

Steps 2 and 3 above are described in more detail below. We also discuss how to upgrade your license to increase the number of
services you can allocate.

AMX License Manager
To use Vision2 you must first license the Master Server using the AMX License Manager. The AMX License Manager is used to install
and manage software licenses for Vision2 (as well as other AMX software applications). The local License Manager application
communicates with a License server which can be based on the local machine or elsewhere on the network. Click the AMX License
Manager shortcut on the master server desktop, once the License Manager launches you are shown the welcome page which lists
the AMX Software you have installed (FIG. 35). Select the product you want to license, in this case Vision2 and click Next to proceed
to the Select License Server dialog where you can either specify an AMX license server on your network if one exists, or install one
locally.

FIG. 35  Select a Product to License
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Select A License Server
Use the options in this dialog (FIG. 36) to install the AMX license Server application on this machine, or select an existing network
license server.

NOTE: Only one instance of Vision2 can be had per AMX license server, otherwise there may be problems with license contention.

Choose one of the Select License Server options:
Use the local license server installed and running on this machine - This is the default option.
Search the network for available license servers - Use this option if the AMX License Server application is already installed 

on your network, for example if you have other AMX products.
Manually enter the license server hostname or IP address - Use this option if the AMX License Server is on the network and 

you know the hostname or IP address or are having problems using the previous option.

Search the Network for License Servers
Proceed as follows:
1. Select the first option and click Next to proceed to the Select License Server dialog. This dialog provides a listing of all AMX 

License Servers detected on the LAN.
2. Select the desired AMX License Server and click Next to proceed to the Select Licensing Option dialog.
3. If your server does not appear in the list, click Refresh. If after refreshing the server list, you still do not see your server, click 

on the link My license server was not listed, let me specify the license server path and enter the hostname or IP address of 
the license server manually.

FIG. 36  Select License Server
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Select Licensing Option Dialog
 The options are as follows (FIG. 37):

Register License By Entitlement ID - Select this option if you are installing a new license.
Request a trial/evaluation license - This option is not available with Vision2.
View Existing Licenses - View existing software licenses for this product.

NOTE:  The license manager will show Vision2 8.2, but it applies to any 8.x versions.
Register License By: Asset ID - Update existing software license/entitlement.

Option 1 is discussed in more detail below. 

Register License By Entitlement ID
This option requires a valid Vision2 Entitlement ID (a license key obtained from AMX). Once this ID is obtained, proceed as follows:
1. In the Licensing Options Menu click Register License by Entitlement ID.
2. This selection opens the Contact Information window. Enter contact information. If already holding an amx.com account, click 

on Lookup Account to provide credentials (email address and password) to automatically populate the contact information for 
this license based on the AMX account information.

3. Click Next to proceed to the Customer Information window. Select your industry sector from the drop down menu.
4. Click Next to proceed to the Install New AMX Product License window, FIG. 38.
5. Enter your Entitlement ID in the text box provided.
6. Click Next to prompt the License Manager to contact the AMX Licensing Server and activate the license associated with the 

Entitlement ID. The License Activated window show if the license was activated.

NOTE: An error message will be displayed if the entitlement has already been registered to another system or if the entitlement ID is 
invalid. Please contact AMX Technical support if you encounter any diff iculties obtaining your product license.

7. Click Next to return to the Licensing Options Menu window (FIG. 38).
8. Proceed to the Vision2 License Management Screen  on page 25. 

FIG. 37  Licensing Options Dialog

FIG. 38  Enter Entitlement ID
24Vision2 Instruction Manual



Licensing
View Existing Licenses
Select the product you want to view licenses for in this case Vision2 and click Next, this screen shows the contents of your license.
In this case of Vision2 it shows the names and quantities of each Vision2 service that you can install on the servers in your Vision2

system. Now that you have licensed your Vision2 system the next step is to apply the services that are contained in your license to
the relevant Vision2 servers. 

Upgrade License
Upgrade your Vision2 license to add more services as follows:
1. Obtain an Asset ID from AMX. A separate Asset ID is needed for each Service to upgrade.
2. Connect to the Master Server.
3. Click AMX License Manager on your master server desktop.
4. Choose the product to license, in this case Vision2.
5. Choose either a local License Server (default option) or a network license server. Use the same option used when installing 

Vision2.
6. Click Next to go to the Licensing Status screen which shows the contents of the current license.
7. Click on Click here if you want to add additional or manage existing licenses.
8. Click Register License by: Asset ID (update existing software license/entitlement).
9. Select your Vision2 Entitlement and click Next.
10. Enter the Asset ID obtained from AMX in the text box provided.
11. Click Next, your new asset is now installed.
12.  Proceed to the Vision2 License Management Screen  on page 25.

Vision2 License Management Screen
Login to the Vision2 user interface using Internet Explorer and go to:
http://<server name>/v2.aspx (where server name is the name of your Vision2 master server) 

Go to Manage System > Manage Licensing to open the License Management Screen, (FIG. 39).

The screen consists of two columns. On the left is the System license column which shows all the licenses available/allocated for
your Vision2 system. Each Vision2 service has its own license. Allocating a license to a server allows users to use a service on that
server. On the right of the screen is the Allocated licenses column showing the list of Vision2 servers installed in your system and a
list of licenses of each type allocated to each server.

NOTE: There is one special row called V2-VOD this is used to allocate video on demand bandwidth to the servers in units of 10Mb/s to 
determine how much video on demand bandwidth each machine can support. All servers which can support Archives are provided 
with 10Mb/s by default (this does not come out of the Users VOD license allowance).

FIG. 39  License Management
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NOTE: Live-Users indicates the number of users who are licensed to view Vision2 live channels using the Live Channels > View page. 

Adding a License to a Vision2 Server
To add a license to a server, click on the row for the license in the System License table and drag and drop the license onto the
Server (FIG. 40). Licenses are ordered by type on the server. Click the arrow to the left of the license name to view all the licenses of
this type. 

The status of each service is indicated by a coloured circle:
Red indicates the service is disabled.
Green indicates it is enabled.

NOTE: Double click a service e.g. MPEG Recorder 1 to jump to the conf iguration page for that service.

Removing a License from a Vision2 Server
To remove a license from a server expand the arrow to the left of the service type (e.g. v2Record) to reveal all the licenses of that
type on the server. Select the license to remove and drag it to the trashcan. A service that is enabled cannot be removed. Double-
click the service to go to the configuration page and Disable it prior to removal. 

NOTE: After removing one or more licenses from a server, reboot the server.

NOTE:  If removing an Archive license, access to the contents of that Archive will be lost.

License Rules Engine
Vision2 operates a rules engine which limits the number of licenses of each type that can be had per server to avoid performance
problems. 

System Limits
A maximum of 10 Record services can be had per Archive service in your Vision2 system. For example if you have two 

Archives services you can have a maximum of 20 Record Services in your system.
A maximum of 10 Producer services can be had per Archive service on the Vision2 system.

Rules for V2-Master-XXXX Servers
This is the only server type which supports Archive services.
The server can support a maximum of 300Mbits/s VOD bandwidth.
The FG3106-03 and FG3106-03K are limited to 20 simultaneous VoD accesses.
Producer/Record services cannot be added to the server unless there is at least one archive in the system.
More VOD Bandwidth cannot be added to a server unless there is at least one archive on the server.

There area number of other rules depending on how much VOD Bandwidth is allocated to the V2-Master-XXXX Server.

Less than or equal to 50MBits of VOD Bandwidth
A maximum of 50 Max CSE Encoders and 19 other services with the following limitations:

The server can have no more than 10 Reflector services.
The server can have no more than 10 Record services.
The server can have no more than 10 Producer services.
A maximum of 6 Archive services

System Licenses Table Columns
Type License name

Total Total number of licenses of this type - this is determined by your AMX license

Allocated Number of licenses allocated to Vision2 Servers

Available Number of licenses of this type still available to allocate to Vision2 servers

FIG. 40  Adding a license to a server - drop the new license on to the Server

Click arrow to expand
and view list of
licenses of this type Number of licenses

of this type
Service disabled
Service enabled
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Greater than 50MBits of VOD Bandwidth
A maximum of 50 Max CSE Encoders and 9 other services with the following limitations:

The server can have no more than 9 Reflector services.
The server can have no more than 6 Record services.
The server can have no more than 9 Producer services.
A maximum of 6 Record services
A maximum of 9 Producer services
A maximum of 6 Archive services
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Manage System
We have already discussed two sub menus contained in the Manage System menu, Licensing and Managing Vision2 servers,
Manage Servers and Manage Licensing. This section of the manual discusses the remaining sub menus.

View Logs
The view logs screen is used to view the logs for Vision2 services and for your Vision2 servers. The two types of log are:

Service Logs - logs for specific Vision2 service
Server Logs - logs for specific Vision2 servers

View a Server log as follows:
1. Set the Servers Logs check box.
2. Select the server whose log you want to view from the drop down menu.
3. Click Apply.

View a Service log as follows:
1. Set the Services Logs check box.
2. Select the service to view from the drop down menu.
3. Click Apply.

Click Download to download the complete log file to a local machine. Click Refresh to view the latest entries in the log (FIG. 41). 

FIG. 41  Event Log
28Vision2 Instruction Manual



Manage System
User Interface Conf iguration
The User Interface Conf iguration screen (FIG. 42) allows the administrator to configure the background screen and cursor colors,
etc for Set-top box and tablet users. This is known as the template. There are two columns in this screen:

On the left is a column used to configure the Tablet background. Use the Templates drop down menu to select a new 
template. Click Apply to update the template. Tablet users will see the new Template next time they login to the Vision2 
system.

On the right is a column used to configure the Set-top box templates. Use the Templates drop down menu to select a new 
template. Click Apply to update the Template. Exit the main Set-top box menu and press and hold the menu button to force 
it to refresh the Template.

Templates are loaded from C:\inetpub\wwwroot\v2Services\ui\Generic\Templates on the master server. Each template has its own
folder. Template folders can be renamed to change the names of the templates and change the images used by the template if
required.

NOTE: The template image filenames, dimensions, and file types must remain the same if changes are made.   

 

Vision2 contains a Template Editor application to create custom user interfaces for set-top box and tablet users. Click Go To
Template Editor to access the editor. FIG. 43 displays the main screen. 

FIG. 42  UI Configuration Screen

FIG. 43  Template Editor - Main Screen
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The following table lists the Device and Template options available in the Template Editor. These options appear across the top of
the screen.

Adding a New Device to the Device List
Adding new devices to the device list is useful due to individual devices requiring specific settings. By adding a new device, you can
create a series of unique templates with settings that work perfectly with that specific device.
Perform these steps to add a new device to the template list:
1. Click Add New Device. A series of options appears (FIG. 44). 

2. Enter the name of the device in the Name f ield.
3. Select the type of device from the Type options menu. Choose from Tablet or Amino.
4. Select the orientation view from the Orientation menu. You can choose from Landscape or Portrait.
5. Use the Width and Height spin boxes to set the size of the screen for the device. You can set each option to any value between 

100 and 5000.
6. Click Create to add the device to the device list.

Device and Template Options
Device Select a device from the available list to view its template. Any new devices you add 

appear in this list.

Add New Device Click to add a new device to the template list. See Adding a New Device to the Device 
List section on page 30 for more information.

Delete Device Click to delete the currently selected device. You will receive a confirmation 
warning before deleting the device.

Template Select a template from the available list. Any new templates created appear in this 
list.

Edit Template Click to edit the template using the settings on the left side of the screen. These 
settings are not available until you click Edit Template.

Save Changes Click to save any changes you make to the template. This button is only available 
after you click Edit Template.

Discard Changes Click to discard any changes you make to the template and return the template to 
its original settings. This button is only available after you click Edit Template.

Delete Template Click to delete the currently selected template. You will receive a confirmation 
warning before deleting the template.

Download Click to load an existing template from a local or network drive.

Upload Click to upload a template to a local or network drive. The Template Editor creates 
a.zip file with all necessary files included within it.

Create New Template Click to create a new template. See the Creating a New Template section on 
page 31 for more information.

FIG. 44  Add New Device Options
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Creating a New Template
Perform these steps to create a new template:
1. Click Create New Template. A series of options appears (FIG. 45). 

2. Enter the name of the template in the Template Name f ield.
3. Use the Create new template as a copy of options menu to select the model of template you want to use.
4. Click Create.
The left side of the Template Editor screen displays a list of options that can be configured for an individual template. These options
are only available after clicking Edit Settings. Changes do not take effect immediately. 
5. After making all necessary changes, click Test to view the changes to the template.
6. Click Save Changes to save the new template settings or Discard Changes to return to the previous settings. FIG. 46 displays 

the Template Editor Settings. 

FIG. 45  Create a New Template

FIG. 46  Template Editor Settings
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The following table lists the settings available in the Template Editor.

Template Setting
Navigation:

Menu Selector Color Use the color chart to select a color for the menu selector.

Render top line navigation Click the check box to render the text on the navigation bar.

Color Use the color chart to select a color for the text on the navigation bar.

Font Size Use the spin box to indicate the size of the text on the navigation bar. Set any value 
between 1 and 255.

Vertical Text:

Render Click the check box to render the text on the left side bar.

X-Offset Use the spin box to indicate the x-offset at which you want to align the text on the 
left side bar. Set any value between 1 and 255.

Font Size Use the spin box to indicate the size of the text on the left side bar. Set any value 
between 1 and 255.

Color Use the color chart to select a color for the text on the left side bar.

Shadow Top Use the color chart to select a color for the top shadow of the text on the left side 
bar.

Shadow Bottom Use the color chart to select a color for the bottom shadow of the text on the left 
side bar.

Thumbnails:

Background Alpha Use the spin box to indicate the alpha used to create the background gradient. You 
can set any value between 0 and 255.

Columns Use the spin box to indicate the number of columns on the navigation pages. You 
can set any value between 1 and 255.

Rows Use the spin box to indicate the number of rows on the navigation pages. You can 
set any value between 1 and 255.

Corner Radius Use the spin box to indicate the size of the corner radius of each thumbnail. You 
can set any value between 1 and 255.

Horizontal Gap Use the spin box to indicate the horizontal spacing between each thumbnail. You 
can set any value between 0 and 255.

Vertical Gap Use the spin box to indicate the vertical spacing between each thumbnail. You can 
set any value between 0 and 255.

Horizontal Margin Use the spin box to indicate the margin on the left and right sides of each 
thumbnail. You can set any value between 1 and 255.

Header Height Use the spin box to indicate the height of the header containing the thumbnail’s 
title. You can set any value between 1 and 255.

Header X-Offset Use the spin box to indicate the x-offset at which you want to align the header’s 
text. You can set any value between 1 and 255.

Header Y-Offset Use the spin box to indicate the y-offset at which you want to align the header’s 
text. You can set any value between 1 and 255.

Font Size Use the spin box to indicate the size of the header text used for each thumbnail. 
You can set any value between 1 and 255.

Header Text Color Use the color chart to indicate the color of the header text for each thumbnail.

Header Color 1 Use the color chart to indicate the first header color used to create a gradient fill.

Header Color 2 Use the color chart to indicate the second header color used to create a gradient 
fill.

Background Color Use the color chart to indicate the color of the background for each thumbnail.

Border Width Use the spin box to indicate the width of the border around each thumbnail. You 
can set any value between 0 and 255.

Border Color Use the color chart to indicate the color of the border around each thumbnail.

Page Indicator:

Render Click the check box to render the page indicator.

Font Size Use the spin box to indicate the size of the page indicator text. Set any value 
between 1 and 255.

Height Use the spin box to indicate the height of the page indicator. Set any value between 
1 and 255.
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FIG. 47 displays the locations of the vertical text, thumbnails, and page indicator on the user interface. 

Y-Offset Use the spin box to indicate the y-offset at which you want to align the page 
indicator. Set any value between 1 and 255.

Color Use the color chart to indicate the color of the page indicator.

Selected Color Use the color chart to choose the color used to indicate the selected page.

Info:

Heading Font Size Use the spin box to indicate the size of the heading text. Set any value between 1 
and 255.

Text Font Size Use the spin box to indicate the size of the information text. Set any value between 
1 and 255.

Heading Color Use the color chart to indicate the color of the heading text.

Heading Background Use the color chart to indicate the color of the heading background.

Section Text Color Use the color chart to indicate the color of the section text.

Background Color 1 Use the color chart to indicate the first color used to create the background 
gradient.

NOTE: The gradient values are used to create a gradient 'wash' over the main info 
image to allow text to be more easily visible.

Background Alpha 1 Use the spin box to indicate the first alpha used to create the background gradient. 
Set any value between 1 and 255.

Background Color 2 Use the color chart to indicate the second color used to create the background 
gradient.

Background Alpha 2 Use the spin box to indicate the second alpha used to create the background 
gradient. Set any value between 1 and 255.

Amino Specific:

Live Channel Highlight Color Use the color chart to indicate the color of the selected live channel.

Live Channels caption Use the color chart to indicate the color of the captions on the live channel.

Live Channel Text Use the color chart to indicate the color of the text on the live channel.

VOD Progress Color Use the color chart to indicate the color of the VoD progress bar.

FIG. 47  User Interface Example 1

Template Setting
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FIG. 48 displays the location of the info header on the user interface.

Set-Top Box Management
Set-Top Boxes support Live Channels or Video on Demand, Stop, Play, Pause, Fast-Forward, and Rewind features. See the Set-Top
Boxes  on page 8 for information on setting up a set-top box. FIG. 49 displays the Set-top Box Management screen. 

FIG. 48  User Interface Example 2

FIG. 49  Set-top Box Management Screen

Info Heading
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The Available Set-Top Boxes area lists the set-top boxes currently detected. This list includes the name, status, channel playing, IP
address, any pending activities and each set-top box type. This list is view-only. Select any set-top box from the list and use the
options below to change its output. Use Ctrl-Click to select multiple set-top boxes and Shift-Click to select a range of set-top boxes.

NOTE: If pushing commands to an Enzo STB that is offline (status shows as offline and a gray dot appears under last update), the 
command will time out and no results are provided.

Users may uncheck the Show offline devices check box at the top of the chart to hide from view any Enzo STBs that are not online.
The set-top box management options are as follows:

Conf iguring Vision2 for use with Active Directory
Vision2 can be configured to use Active Directory to authenticate users when they login to the system and to determine access
rights to Vision2 archives and services. If intending to use Active Directory, the XML file web.config located in the
C:\inetpub\wwwroot\v2 directory on your master server must be edited. The contents of this file are used to impersonate a chosen
user when communicating with the Active Directory server. For this reason, the user defined by these settings must have read
rights on the Active Directory server. The file contains the following keys:

LdapUserName - The name of user to impersonate
LdapDomain - The domain in which the Active Directory server resides
LdapPassword - The password of the user to impersonate
LdapServerURL - This is the URL for your Active Directory Server

There is an additional key in this file called LdapUserAttributeContainingLoginName, this key contains the name of the attribute
within the user Distinguished Name (DN) which holds the value that the user supplies when they log in. For a normal Active
Directory implementation, this value is sAMAccountName.

A user group can also be set to act as Administrators. Set the key AdministratorGroupName to the DN path for the Active Directory
group to give access top. The Administrator Windows NT user account on the master server can still login as well.
An example is as follows:
    <!--Start Administrator Settings-->
    <add key="AdministratorsGroupName" value="CN=AMX London,OU=Security Groups, 
OU=Europe,DC=amx,DC=internal" />

    <!--End Administrator Settings-->

Next go to the User Access Control screen and change the Access Control type from NT User Groups to LDAP.

NOTE:  IIS must be restarted on the master server / or reboot the master server after changing access permissions from LDAP to NT 
User Groups or vice versa. 

Once LDAP authentication has been chosen, any user in your organization can login to your Vision2 system using their standard
username and password.

NOTE: Users can login without entering their domain name, for example, user bob who is a member of the domain AMX can login 
using bob rather than AMX\bob.

Now that LDAP has been enabled, it is recommended to restrict access to V2 services. Go to Manage System > V2 services
permission and enable V2 services access control. You will also need to restrict access to your Archives. Go to Archive > Archive
Permissions and enable Archive User Access control on each of the Archives. 
Any user who logs in using LDAP will now only be able to view Live Channels. Refer to the Archive Permissions and V2 Services
Permissions sections for more information about allowing access to Archives and Vision2 service configuration pages.

NOTE: When adding a Vision2 system to a corporate domain, the Windows 2008 operating system on the Vision2 servers will block 
multicasts created on those servers. The windows f irewall must be conf igured on each Vision2 server to allow multicast listener Query, 
report and Report v2 through the f irewall at the local subnet level on the Domain setting.

Set-Top Box Management Options
Name Enter a name for the set-top box.

Rename Click to apply the edited name to the set-top box.

Move Up/Move Down Moves the selected set-top box up or down in the list.

Delete Removes the set-top box from the list.

Play Live Channel Select a live channel to play through the set-top box. Click Apply when finished and 
the set-top box begins playing the live channel.

Play Video On Demand Select a video on demand to play through the set-top box. Click Apply when 
finished and the selected video on demand becomes available.
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User Access Control
The User Access Control screen determines the type of User Access Control used to log in to Vision2 and determines the source of
the User Groups shown in the V2 Service permissions and Archive Permissions screens (FIG. 50). 

There are two types of user access:
NT User Groups - NT User Groups on the Vision2 master server
LDAP - Active Directory

The user access control options are as follows

Click on a folder or item in the Group Name column to set the LDAP Base DN to the Path value for the currently selected 
item. Expand the folders if necessary to view the contents.

Click Validate to check the new Base DN is an OU and to navigate down the LDAP hierarchy until you find a level to view the 
user groups in your organization to give access to specific archive folders or Vision2 services. The list of groups shown in 
the User Access screen will now be available in the Archives > Permissions screen and Manage System > V2 Services 
Permissions. Changing the LDAP Base DN will not remove any permissions that have been set already.

V2 Services Permission
The V2 Services Permissions screen (Manage System > V2 Services Permissions) is used to configure what operations different
users can carry out on the different services in the Vision2 system. By default all users are allowed to do any operation on any
service. If User Access Control is enabled, then access to Vision2 Services will be restricted based on the group that the user
belongs to. This is either NT User Groups on the Vision2 master server, or LDAP groups depending on what option was selected in
the User Access screen, The administrator user account still has full access to all Vision2 services. When user access is enabled
then a user with no permissions configured can only browse archives and play live channels. Access to archives is controlled by a
separate screen Archives > Archive Permissions.
The V2 Services Permissions contains two columns:

The left hand column contains a list of User Groups. If you have selected LDAP this is a list of user groups under the LDAP 
Base DN path selected in the Manage System > User Access screen.

The right hand column contains a list of servers in your Vision2 system, expand a server to see the services allocated to that 
server. Expand a service to see the operations available for that service.

Carry out the following actions to allow members of a user group to access a service:
1. Select the server to allow access to using the Select V2 Server drop down. There are two columns:

The left hand column shows the available User Groups.
The right hand column shows the services on this server.

2. Expand the server and service to give access to in the right hand columns. This shows the different permissions available on 
this service.

3. Drag the user group to give access to from the left hand column and drop it under the correct permissions.
4. Repeat steps 2 and 3 for all permissions, services, and user groups.
5. Click Apply.

NOTE: The new permissions will take effect as soon as you click Apply. However the menus shown to the affected users will not 
change until they login again.

FIG. 50  User Access Control screen

User Access Control Options
Access Control Type Select the appropriate option to indicate whether user access control is controlled 

by Windows NT User Groups or LDAP.
Note if you change Access Control Type then you must either reboot your V2 
Master Server or restart IIS.

LDAP Base DN This is the path of the currently select Group.
Example value:

OU=Europe,DC=amx,DC=internal

Validate Click this button to apply the LDAP settings

Root Click to go back to the Root of the LDAP tree

Save Click this button to save the selected LDAP path
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FIG. 51 shows a typical scenario. Members of Users have permission to change the Service Name and Enable/Disable MPEG
Recorder 1 on Server AMXUKDISID. FIG. 52 shows the effect of these permissions.

Click Reset to undo any changes made to the permissions since entering this screen.

FIG. 51  User Group Users Have Permissions To Enable/disable Mpeg Recorder1 And Change Service Name

FIG. 52  Example to Show The Effect Of Vision2 Service Permissions Set in FIG. 51

The user only has access 
to these sections of the
Recorder Configuration page.
All other configuration
sections are grayed out.

 

37Vision2 Instruction Manual



Manage System
VOD Bandwidth
The VOD bandwidth page (FIG. 53), Manage System > VOD Bandwidth is used to view bandwidth usage and see whether it is
exceeding the limits set by your license. There are three tabs at the top of the page:

System Report - shows the vod bandwidth and multicast bitrate usage for your whole system.
Server Report - shows the vod bandwidth and multicast bitrate usage for a selected server.
Configuration - used to select which network interface card to monitor on each server.

Server and System Report Tab
The system report and server report tabs work in a similar way. In the server report tab you must select the server to monitor using
the Select Server drop down menu and click Load before continuing. This step is not required in the system report tab.
The top section of the page contains three dials which show from left to right:

Combined bitrate - the total bandwidth on the selected network interface card.
Multicast bitrate - the current Multicast bandwidth on the selected network interface card.
VOD bitrate - the current video on demand bandwidth on the selected network interface card.

The two historical bandwidth graphs at the bottom of the page shows the VOD bandwidth used within the chosen date range. By
default all data is shown since the system was commissioned. 

The upper graph is used to view the data. 
The lower graph is used to pan over the selected date range and zoom in on an area to examine it in more detail. 

Use the two calendar icons to change the date range to view. The data is averaged over a 1 hour time period. Use the Graph Scale
drop down to change this setting. The graph form drop down is used to select the way the graph is presented.

FIG. 53  VOD Bandwidth Page

VoD bandwidth limit for this server
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Click Refresh to update the graph to see the latest readings. Use the white bar at the bottom of the page under the graph to pan
over and zoom into the selected data range as follows:

Click and drag the bar left or right to pan.
Click and drag the edges of the bar left or right to zoom in or out as required (FIG. 54). 

A red line appears on the upper server report graph which indicates the VOD bandwidth limit set by the VOD bandwidth license
configured on that server. This allows you to see if you are exceeding that limit.

Conf iguration
The configuration tab is used to select which network interface card to monitor on each server. The table contains a list of the
servers in your Vision2 system and a selected NIC column. Use the drop down icon in the selected NIC column to choose the IP
address of the network interface card to monitor on that server. 

FIG. 54  Zooming in on a Region of the VoD Bandwidth Graph

FIG. 55  Configuring the Network Interface Card to Monitor on Each Server

Drag bar to pan

Drag to zoom
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Changing the Channel Order
The Channel Order screen (Live Channels > Channel Order) is not accessible from the Manage System menu but is only available to
administrators. This screen is used to change the order in which live channels are listed to PC and Set-top box users (FIG. 56). This
screen is also used to add unmanaged channels to the system. Unmanaged channels are video streams that users can view that are
not managed by the Vision2 system. 

The following options are available on the Manage Channel Order page. 

Perform these steps to change the channel order:
1. Select a channel in the list.
2. Click Move Channel Up or Move Channel Down until the channel is in its appropriate location.
3. Click Save Changes.

Adding an Unmanaged Channel
If you have a non-Vision2 video source, you can create an unmanaged channel for it. Perform these steps to add an unmanaged
channel:
1. Click Add Unmanaged Channel. A dialog box appears (FIG. 57). 

2. Enter the name of the channel in the Channel Name text box.
3. Select the type of channel from the Type options menu. Vision 2 supports three types of unmanaged channels:

Multicast Windows Media Stream
Multicast MPEG-2 Transport Stream (MPEG-2 Video) SD and HD
Multicast MPEG-2 Transport Stream (H264 Video) SD and HD

NOTE: H264 video streams in FLV and other formats are not supported.

4. Enter the Channel Name.
5. Enter the channel URL for the Windows Media Stream or the multicast address and port for MPEG 2 or MPEG h264 channels.
6. Click Add. The channel will now appear in the list.
7. Click Save Changes to confirm the changes.

FIG. 56  Manage Channel Order

Manage Channel Order Options
Add Unmanaged Channel Adds an unmanaged channel to the Channel Order list.

Channel Name The name of the channel as it will appear in the Channel Order list.

Type The type of stream for the channel.

Channel URL The URL of the video source.

Delete Unmanaged Channel Removes an unmanaged channel from the Channel Order list.

Move Channel Up Moves the selected channel one position up in the list.

Move Channel Down Moves the selected channel position down in the list.

Save Changes Saves the changes to the channel order list.

FIG. 57  Add Unmanaged Channel
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Live MPEG MAX CSE Encoder Service
The Vision2 Live MPEG Max CSE Encoder Service is used to control a MAX CSE encoder and view its output as one of your Vision2 
Live Channels. This allows users to add a analogue video source such as a camera to a Vision2 system. Once the Encoder is 
configured, the Live channel it creates can be used as a source for a Record Service or for display as part of a Producer channel. PC 
and set-top box users can also view this Live channel as part of the Live Channels list. The Live MPEG service uses an AMX MAX-CSE 
encoder (FG2178-70) to provide the hardware encoding of video and audio signals into an MPEG-2 multicast stream.
Select Live Channels > Manage MAX CSE Encoders to open the MAX-CSE Encoder configuration page. (FIG. 58): 

The top section of the page deals with the settings for the service itself and consists of the following options:

Perform these steps to connect to a MAX-CSE Encoder:
1. In the Service Name text box, enter the name of the Live channel to appear to PC and set-top box users in the Live Channels 

list.
2. Enter the network IP Address of the encoder in the Encoder IP Address text box. You can find the IP address of the MAX-CSE 

encoder on the LED on the front of the unit.
3. In the Username text box enter the username used to gain access to the encoder. The default username is Admin.
4. In the Password text box, enter the password used to gain access to the encoder. The default password is 1988.
5. Click Apply. If the correct details have been entered, the Encoder Settings section will update to the values configured on your 

encoder.
If an incorrect IP address is entered, the system will attempt the connection for 10 seconds and then, if unsuccessful, the following 
message will appear at the bottom of the page: “The encoder is not responding, the IP address is incorrect or the encoder is 
offline.”
If the encoder has different multicast settings to the values in Vision2 then you will be prompted to click Apply and update the 
multicast settings. If the encoder is enabled, disable it before updating the settings.

FIG. 58  MAX-CSE Encoder Configuration

Encoder Access Settings
IP Address The network IP Address of the encoder. The IP address of the MAX-CSE encoder 

can be found on the LED display on the front of the unit.

Username The user name required to manage the device. The default user name is Admin.

Password The password required to manage the device. The default password is 1988.
41Vision2 Instruction Manual



Live MPEG MAX CSE Encoder Service
Multicast Settings
The multicast settings section of the page shows the multicast settings used for the output video stream from the encoder 
(FIG. 59). When enabling the stream, the MAX encoder starts the encoding process and multicasts video on the specified IP address 
and port. Modify these values if you want to use different settings.

The following options are available in the multicast section:

Encoding Settings

The following options are available in the encoding section:

Once encoder access details have been entered and multicast settings setup, perform the following steps to configure the encoder:
1. Use the Video Input options menu to indicate whether you are connecting to the S-video or composite port on the MAX 

encoder.
2. Use the Video Standard options menu to set which video standard the MAX encoder is using.
3. Use the Aspect Ratio options menu to set the aspect ratio you want to use for the multicast stream.
4. Use the Video Resolution options menu to indicate the video resolution of the multicast stream.
5. Use the Video Bitrate options menu to set the video bitrate of the multicast stream.
6. Use the Video Mode options menu to set the video mode of the multicast stream. It is recommended that you select CBR.

FIG. 59  MAX Encoder Multicast Settings

Multicast Settings Options
Protocol Vision2 only supports the UDP multicast protocol. If the encoder is set to the RTP 

protocol, change this setting and apply the changes.

Address This is the multicast address of the Encoder output stream.

Port This is the port number used by the Encoder output stream.

TTL This is the multicast TTL setting for the Encoder output stream.

FIG. 60  Encoding Settings

Encoding Settings Options
Video Input The MAX encoder supports either S-Video or Composite video inputs.

Video Standard The MAX encoder supports the NTSC (USA and Japan) and PAL (rest of the world, 
excluding France) video standards.

Aspect Ratio The MAX encoder supports a 4:3 and 16:9 aspect ratio.

Encoder Profile Vision2 only supports the MAX Custom encoder profile.

Video CODEC Vision2 only supports MPEG-2 video compression on the MAX encoder.

Video Resolution The MAX encoder supports D1 (720 x 576 PAL / 640 x 480 NTSC) and SIF (360 x 
288 PAL / 320 x 240 NTSC) resolutions.

Video Bitrate The MAX encoder supports a range of selected video bitrates from 2 Mbits to 6 
Mbits. Bitrates under 2 Mbits are not supported. The recommended encoding 
bitrate is 6 Mbits.

Video Mode The mode to use for encoding video. The MAX encoder supports constant Bit Rate 
(CBR) and variable Bit Rate (VBR) modes. For multicasting, CBR is recommended as 
it produces a constant rate over the network.

Audio CODEC The codec to use for encoding audio.Vision2 supports MP3 and MP2 audio.

Audio Bitrate The MAX encoder supports audio bitrates of 96K and 192K.

Audio Sample Rate The MAX encoder supports audio sample rates of 32, 44.1, and 48K.
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7. Use the Audio Bitrate options menu to set the audio bitrate of the multicast stream.
8. Use the Audio Sample Rate options menu to indicate the audio sample rate of the multicast stream.
9. Click Apply to save the configuration changes.
10.  Change the Service Enable from No to Yes and click Apply to begin the multicast stream. This will also add a new live channel 

to the list of Live Channels available to PC and set-top box users which takes its name from the Encoder’s Service Name.

NOTE: With the stream enabled, you cannot change any of the multicast or encoding parameters.

Viewing the Stream
Click the Watch button, which appears after enabling the stream, to view the encoder output. The Encoder Live Channel takes its 
name from the Service Name text box in the Max Encoder configuration page. Change the Service Name to change the channel 
name.

NOTE: If conf iguring a f irewall on Vision2 servers, then incoming multicasts must be permitted.
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Reflector Service
The Vision2 Reflector Service is used for the following tasks:

To unicast a local MPEG 2/ MPEG 4 h264 Vision2 channel over the Internet (multicast streams cannot travel over the 
Internet) so that remote users can view this channel. This could be to a remote Vision2 installation.

To receive a unicast MPEG 2/ MPEG 4 h264 Vision2 stream from a remote Vision2 installation and broadcast this as a local 
live channel.

To add an external source e.g. unicast MPEG 2/ MPEG 4 h264 stream from the internet/local network as a local live channel. 
Like unmanaged channel but for unicast rather than multicast.

To make a copy of a local MPEG 2/ MPEG 4 h264 Vision2 channel and broadcast it from a second network interface card. 
This is less common but is useful if your network can’t do multicast routing between different network subnets.

NOTE: The Reflector Service cannot use HD h.264 Live Channels as a source.

An MPEG Reflector can receive both unicast or multicast input streams and output either unicast or multicast streams. Access the 
Reflector management screen (FIG. 61) by going to Live Channels > Manage MPEG Reflectors.

The following options appear on the Reflector service configuration page:

FIG. 61  Reflector Configuration Page

MPEG Reflector Service Options
Service Enable This enables the service and will begin multicasting or unicasting as appropriate. 

Note: Settings cannot be edited while the service is enabled.

Service Name The name of the channel to display in the Live Channel list for PC or Set-top box 
users. Note: this only applies to multicast streams.Unicast streams cannot be 
viewed in the Live Channels list.

Source
Type Click the appropriate option button to indicate the source type. Choose from either 

a Local Vision2 Channel or an External Source.

V2 Channels The options menu provides a list of all the live channels in the system. This option 
is only available if selecting Local Vision2 Channel as the source type.

URL Use this text box to enter the URL containing an MPEG-2 or H.264 video stream. 
This option is only available if selecting External Source as the source type.

Destination
Stream type Click the appropriate option button to indicate the stream type. Select Multicast if 

streaming over an Intranet. Select Unicast for Internet streaming.

Multicast options These options are only available if selecting Multicast as the Stream type.

Continued
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Activating a Unicast Stream
Perform these steps to activate a unicast stream:
1. Select and load the Reflector service to configure.
2. Choose whether the source is a Live Channel or an external source by clicking the Local V2 Channel or External Source 

option button.
If selecting Local V2 Channel, select the source Live Channel from the V2 Channels drop down menu.
If selecting External Source, enter the URL of an address containing an MPEG-2 or H.264 video stream in the URL text box.

3. Click the Unicast option button to select a unicast stream.
4. Select the IP address of the network card to use to output the unicast stream by using the NIC drop down menu.
5. Enter the port number in the Port text box.
6. Click Apply in each section if any changes were made to the Reflector configuration.
7. Change the Service Enable setting from No to Yes and click Apply. The Reflector will now begin unicasting the video stream as 

configured. No Live Channel is created for this stream as Live Channels are only used for multicast streams.

Activating a Multicast Stream
Perform these steps to activate a multicast stream:
1. Select and load the Reflector service to configure. 
2. In the Service Name box, enter the channel name as you want it to appear in the Live Channels list for PC or set-top box users.
3. Choose whether the source is a Live Channel or an external source by clicking the Local V2 Channel or External Source 

option button.
If selecting Local V2 Channel, select the source Live Channel from the V2 Channels drop down menu.
If selecting External Source, enter the URL of an address containing an MPEG-2 or H.264 video stream in the URL text box.

4. Click the Multicast option button to select a multicast stream.
5. Select the IP address of the network card you want to use to output the multicast stream by using the NIC drop down menu.
6. Click Apply in each section if you made any changes to the Reflector configuration.
7. Change the Service Enable setting from No to Yes and click Apply. The Reflector will now begin multicasting the video stream 

as configured. A new Live Channel will appear in the Live Channels list with the name specified as the Service Name in step 2 
above.

Viewing the Reflector Output Stream
If the Reflector destination stream type is set to multicast then you can click the Watch button which appears after enabling the 
stream to view the reflector output in the Live Channels > View screen. If the Reflector destination stream type is set to unicast, 
check that the stream is being output correctly by opening the VLC player application on a remote machine. Choose Media > Open 
Network Stream and enter the URL in the destination section of the Reflector page into the Please enter a network URL text box 
e.g.:
 http://192.168.81.56:8000/MpegReflector1 

and click Play to view the stream. If you have a DNS server, use
 http://<servername>:<port>/<MPEG reflector service name>

Address The multicast address for this channel.

Port The multicast port for this channel.

TTL The multicast TTL (Time to live) for this channel.

NIC The IP address of the Network Interface Card to use for multicasting.

Unicast options The following options are only available if selecting Unicast as the Stream type.

NIC The IP address of the Network Interface Card to use for unicasting.

Port The unicast port for this channel. 

URL (cannot modify) This text area shows the URL for the unicast stream.

MPEG Reflector Service Options
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DVB Service
The Vision2 DVB Service provides and manages a single Digital Video Broadcast (DVB) multiplex of live TV channels to the system. 
Terrestrial, satellite, and cable TV providers now use a digital rather than analog transmission systems to deliver their content. 
Where previously a single frequency was required for each TV channel, by using digital compression, multiple channels can be 
provided on a single frequency (known as a multiplex or bouquet). The DVB service de-multiplexes the individual TV channels on a 
selected frequency and makes each individual channel available for multicasting to PC and set-top box users.

DVB Tuners must be connected to a network accessible by the 2nd Network Interface Card (2nd NIC). Go to Live Channels > 
Manage Digital Tuners to access this screen. Vision2 supports the following Tuners types:

Conf iguring a DVB Tuner Service
Steps to setup a DVB tuner:
1. Configure Tuner Hardware.
2. Configure Tuner Multicast Settings.
3. Scan Tuner for Available Channels.
4. Multicast Selected Channels.
These steps are described in detail below.

Conf igure Tuner Hardware Settings
Select the appropriate tuner type using the drop down menu and click Apply (FIG. 62).

Conf igure Tuner Multicast Settings
Vision2 can output multicast streams for selected tuner channels (FIG. 63). 

 Configure the settings to use for these streams as follows:
1. Use the NIC drop down in the Multicast Output Streams section to select which network interface to use for multicasting. 

Typically this is the first network interface card connected to your LAN.
2. Enter the base multicast address in the Base Multicast Address text box. All channels chosen to transmit are multicast using IP 

addresses which are offset from this address. For example, if the Address is set to 234.0.0.0, the first channel in the select to 
transmit table is multicast on 234.0.0.0, and the second 234.0.0.1, etc.

3. Enter the port to multicast the output streams on in the Port text box.
4. Enter a value for the TTL setting for the output multicast streams in the TTL text box.
5. Click Apply to save the changes to the settings.

NOTE: Once some channels are enabled in the Select to Transmit table, you will be unable to change the settings in the Multicast 
Output Streams section.

Supported DVB Tuners
Tuner type FG Description

AMX DTV-TX01 DVB-T FG1410-01 Terrestrial SD Digital TV Tuner (use outside North America)

AMX DTV-TX02 DVB-S FG1410-02 Satellite SD Digital TV Tuner. (use outside North America)

AMX DTV-TX03 ATSC FG1410-03 ATSC HD Terrestrial Digital TV Tuner. (use within North America)

AMX DTV-TX03 QAM FG1410-03 QAM HD Digital Cable TV Tuner. (use within North America)

FIG. 62  Tuner Hardware Settings

FIG. 63  Multicast Settings
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Scan Tuner for Available Channels
The Scan Tuner section (FIG. 64) is used to scan all of the frequencies used by the broadcaster and detect all of the available TV 
(and optionally Radio) channels. 

NOTE: The DVB system does not support the decoding of encrypted channels, therefore encrypted channels are not added to the 
channel list when they are detected.

Perform these steps to scan for available channels on all frequencies:
1. Enter the multicast address of the tuner to scan.
2. Enter the port used by the tuner multicast in the Port text box.
3. Choose whether to scan for Radio Channels as well as TV channels. Select Yes for the setting Include Radio Channels to 

include radio channels.
4. Click Start. Vision2 begins to scan for available channels. Any channels it finds appear in the Select Channels to Transmit table.

Transmit Selected Channels
This section describes how to transmit DVB Tuner channels on your network. Users can view these channels in the Live Channels 
menu, or from set-top boxes attached to your system. The process is as follows:
1. In the Select Channels to Transmit Table, click the check box in the Multicast column for the channels to transmit. This channel 

will now be added to the list of Live Channels that can be viewed by PC or Set-top box users. Repeat this step for each channel 
to multicast. To stop transmitting a channel, just click again to deselect the check box. The channel will be removed from the 
list of Live Channels.

NOTE: If using one of AMXs DTV-TX transmitters, all programs in the stream may appear in the TVCT table for your transmitter device 
even when the transmitter is conf igured to only stream certain channels.

Channel To Transmit Table
On the right of the page is a table containing a list of TV (and optionally Radio) channels available from the selected Tuner. This 
table contains the following information:       

NOTE: If conf iguring a f irewall on Vision2 servers, incoming multicasts must be permitted.

FIG. 64  Scan for Channels Settings

Scan for Channels Options
Multicast Address The multicast address of the output of the tuner you want to scan.

Port The port of the output of the tuner you want to scan.

Start Start the process of scanning for the available TV or Radio channels.

Stop Stop the scanning process. Only use this if you wish to return later and run the 
scan process again, as not all of the channels may have been detected.

Include Radio Stations Enable this option to scan for Radio as well as TV channels.

Channel List Options
Watch Click a Play button in the watch column to view/listen to a particular Channel.

NOTE: This option is only available if the Multicast column is enabled for this 
Channel.

Name The channel name as provided by the broadcaster.

Type The type of channel, either Digital TV or Digital Radio.

Multicast Checking the box multicasts the channel.

NOTE: If using one of AMX’s DTV-TX transmitters, all programs in the stream may 
appear in the TVCT table for your transmitter device even when the transmitter is 
conf igured to only stream certain channels. To avoid displaying channels that are 
not available in the stream, do not choose individual channels to stream, and instead 
stream the full transport stream.

SID This is the DVB Service ID, provided for technical users.

PMID This is the DVB Program Map ID, provided for technical users.
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Archive Service
The Vision2 Archive service provides a multi-format, multi-bitrate storage system for video or audio files. Video in the archive can
be accessed on demand by PC users, from tablets, or set-top boxes. Users can attach metadata to each video containing
information about the video contents. This metadata can be customized by the system administrator. Vision2 provides some built in
metadata sections such as synopsis to provide an overview of the video and credits to detail the authors of the video. The Vision2

search feature can be used to search videos by the contents of the metadata. One or more archive licenses can be added to a server
to provide more than one storage area on that server. Vision2 also allows an archive to point to a NAS/SAN to add extra storage to
a Vision2 system. Archive video/music files can be used as the source for a Producer service, which provides a scheduled multicast
TV channel. The Archive service supports MP3 audio and four types of video file: WMV, MPEG2, MPEG4, and Flash Video (FLV). A
Live Channel can also be recorded and the resulting video saved into an Archive.

Setting Up an Archive
In order to setup an Archive, first decide whether to store the videos on a Vision2 server, a SAN, or a NAS. The latter option is called
a NAS archive and is only permitted on Master servers.

 If the former, look at the amount of free space on each available server. Once the appropriate server is found, use the
Manage Licensing screen to add an Archive license to the server. See Configuring a Standard (non-NAS) archive below for
more details.

If the latter see Setting Up a NAS Archive  on page 49 for more details.
If needing to store videos on a SAN the process is similar to configuring a NAS archive. See Conf iguring a SAN Archive  on

page 60 for more details.

Conf iguring a Standard Vision2 Server (non NAS) Archive
Configure a Standard Vision2 Server (non NAS) Archive on one of your Vision2 servers as follows:
1. Go to Manage System > Manage Licensing.
2. Drag an Archive license on to the server to host that Archive.

NOTE:  Record and Producer services can only use archives which are located on the same server. This restriction does not apply to 
NAS archives. Recorder and Producer services on either Master or Slave can use the NAS archive even though the NAS archive can 
only be licensed on the Master.

3. Double-click an Archive license to configure that Archive. If not using a NAS archive, you will not need to change Archive
configuration settings other than the Service Name (this is the name used for this Archive in the User Interface). The
Configure Archive screen contains the following options (FIG. 65): 

FIG. 65  Archive Configuration Screen

Conf igure Archive Options
Service Name The name of the archives as it appears to PC, tablet, and set-top box users.
48Vision2 Instruction Manual



Archive Service
NOTE: Once an Archive is conf igured, the settings should not be changed (except the service name) as access to the data will be lost.

Setting Up a NAS Archive
NOTE: A NAS archive service should only be licensed on Master Servers.

A NAS archive requires a Vision2 server running release 8.2.4327 or greater. 

    To conf igure the NAS server:
1. Create a folder on the NAS that you want to use to store your archives contents, for example: ArchiveNAS, so that the UNC 

path to this folder is:
\\NASservername\ArchiveNAS

2. Create the user “v2system” with password “Vision2” and give read and write permissions for the ArchiveNAS folder.

    Vision2 Server Conf iguration:
If your Vision2 system is not preconfigured with a v2system user, perform the following steps to create a v2system user. Also, if you
have a Slave server that needs access to the NAS archive licensed on the Master, you would also need to create a v2system user on
Slave.
1. In Windows, select Start > Control Panel > Administrative Tools > Computer Management > Local Users and Groups.
2. In the Computer Management dialog, select Users, and right-click and select New User to open the New User dialog (FIG. 66).

Create a new user named “v2system” with the password “Vision2”. 

3. Check the User cannot change password and Password never expires check boxes. Click Create and then click Close. 
4. In the Computer Management dialog, right-click the “v2system” user and select Properties. 
5. In the Properties dialog, select the Member of tab, and click Add.
6. In the Select Groups dialog, click Advanced

Archive Path The locations of the thumbnail images and info.xml (metadata) files, this should
always point to the local server. You should not need to change the default value.
Note this setting must be unique for this Archive, no other archive should use the
same path. This folder must be indexed via Windows Search Service otherwise
Archive Search will not function correctly. Note this setting must be unique for this
Archive, no other archive should use the same path.

Content Archive This is the path to the media (video/audio) stored in the Archive. This can be on the
local server or on a NAS drive. You only need to modify this setting for NAS
archives. Note this setting must be unique for this Archive, no other archive should
use the same path.

Base Video URLs These settings define the protocols and paths used to access the content in the
archive. You only need to modify these settings for NAS archives.

FIG. 66  New User Dialog

Conf igure Archive Options
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7. In the next dialog, click Find Now, and select Administrators from the list that appears. Click OK to close this dialog, and click
OK again to close the Select Groups dialog.  

8. In the v2system Properties dialog (FIG. 67), remove Users from the list, and click Apply. You can close the Computer
Management dialog. 

NOTE: If a Slave server is required to access the NAS archive that is licensed on the Master, repeat these steps to create a user on the 
Slave server.

9. In Windows, select Start > Administrative Tools > Services.
10. Stop the “AMX Vision2” service.
11. Select “AMX Vision2” > Properties and select tab Log On.
12. In the Log On tab (FIG. 68), check “This Account” click Browse > Advanced > Find Now and select “v2system”. Click OK and

OK. 

13. Enter and confirm Password “Vision2”, click Apply and OK the alert Log on pop up. 
14. Repeat steps 9-13 for the Slave server if applicable.
15. In Windows, select Start > Administrative Tools > Services.
16. Stop the “AMX V2RTSP” service.
17. Select “AMX V2RTSP” > Properties and select tab Log On.
18. In the Log On tab (FIG. 68), check “This Account” click Browse > Advanced > Find Now and select “v2system”. Click OK and

OK.
19. Enter and confirm Password “Vision2”, click Apply and OK the alert Log on pop up.

NOTE: Do not restart these services at this time. 

20. You can now exit from Services. 
21. Open Start > Administrative Tools > IIS Manager. 

FIG. 67  V2 System Properties "Member Of" Tab

FIG. 68  AMX V2 Propertied Log On Tab
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22. Select Connections > Sites > Default Web Site > v2, you will see a folder called Archives. 
23. Right click the Archives Folder and select Add Virtual Directory.
24. In the Alias text box enter “ArchiveNAS”.
25. Set the PhysicalPath text box to the UNC Path to the folder on the NAS e.g:

\\NASservername\ArchiveNAS  (FIG. 69)

26. Select "Connect as" and check “Specific User”.
27. In the Set Credentials window (FIG. 70), select Set and enter the username “v2system” and password “Vision2” for the NAS

share and click OK.

FIG. 69  Remove Users from the Member of list

FIG. 70  Set Credentials Dialog
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28. Click Test Settings and confirm the user is valid and the path is accessible. Click Close.

Configure the V2AppPool to use the identity of the “v2system” user. 
29. In the IIS Manager (FIG. 72), select Connections > Application Pools.
30. Right-click V2AppPool and select Advanced Settings.
31. Under Process Model, select Identity and click the (...) button. 

FIG. 71  Test Connection dialog

FIG. 72  Application Pools
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32. Select Custom Account. 
33. Click Set, and enter “v2system” for the user name and “Vision2” as the password for the NAS User account (FIG. 73). 

34. Repeat steps 21-25 for the Slave server if applicable.
35. Click OK to close the dialog. 
36. Click OK and close the dialog.
37. Right-click V2AppPool and select "Recycling..." (FIG. 74).

38. Uncheck "Regular time intervals (in minutes).
39. Check "Specific Times" and enter 3:00 AM.
40. Click the next button.
41. Click the Finish button.
42. Restart IIS.
43. Restart the AMX Vision2 service.

FIG. 73  Advanced Settings

FIG. 74  Application Pool Recycling Settings
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44. Open the V2 Manager UI and login as administrator.
45. Select Manage System > Manage Licensing.
46. Drag an Archive license onto the server you want to host the NAS Archive. This must be on the same server on which you have

performed the above configuration.
47. Double-click the New Archive license to configure the Archive (FIG. 75).  

48. Do not change the Archive Path but set the Content Archive text box to the UNC Path of the NAS Archive, for example: 
\\NASservername\ArchiveNAS

The Available Storage on this Drive graphic will change and display the New Storage space on the NAS.
49. Change the following Streaming URLs to point to the NAS drive Virtual Directory. Edit existing URLs excluding the Flash URL.

For example, from:
MPEG-2 = http://<servername>/v2/Archives/ArchiveX

     to
MPEG-2 = http://<servername>/v2/Archives/ArchiveNAS

50. Click Apply to save the changes.
51. The server is now configured to use the NAS share for the Archive service.
52. Restart the server.

NOTE: Once an Archive is conf igured and media is started to upload to the archive, do not change the settings (except the service 
name) as access to the data will be lost.

FIG. 75  Configure Archive

FIG. 76  Configure Archive Screen Modified
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 Add FTP Support for NAS Archive on a V2 Server (Release 8.2) 
NOTE: A NAS archive service should only be licensed on Master Servers.

1. Open Start, Administrative Tools, and IIS Manager.
2. Select Connections > Sites > Archives > (FIG. 77). This is the FTP site.  

3. Right click on Archives site and select Add Virtual Directory (FIG. 78).
4. In the Alias text box enter “ArchiveNAS”.
5. Set the PhysicalPath text box to the UNC Path to the folder on the NAS e.g:

 \\NASservername\ArchiveNAS 

6. Select Connect as and check “Specific User”.

FIG. 77  NAS FTP Support - IIS Manager

FIG. 78  NAS FTP Support - Add Virtual Directory
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7. Select Set and enter the username “v2system” and password “Vision2” for the NAS share and click OK (FIG. 79).

8. Select Test Connection and confirm user is valid and path is accessible (FIG. 80).
9. Click Close.

FIG. 79  NAS FTP Support - Set Credentials

FIG. 80  NAS FTP Support - Test Connection
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10. The IIS Manager should now resemble FIG. 81.

11. Exit IIS Manager.
12. Now launch the v2FTP client from remote PC.
13. Login and enter the Master V2 server name.
14. Select the NAS archive, on my server its Archive Service 2 and click Load Archive (FIG. 82).

FIG. 81  NAS FTP Support - IIS Manager Modified

FIG. 82  FTP Client Screen 
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15. You should now see the folders available or the Archive (FIG. 83).
16. Select the required file to upload.
17. Select the Bitrate and check Published.
18. Select the folder to upload the file to on the archive.

19. Select add media to the Upload Basket.

FIG. 83  FTP Client - File Selection
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20. Then Select Upload Basket. 
21. Select Upload (FIG. 84).

22. File should now start to upload to the Archive.
23. When upload is complete (FIG. 85) Click OK.

24. Time taken to upload depends on the size of the media file and network speed.

FIG. 84  FTP Client - File Upload

FIG. 85  FTP Client - File Uploaded
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Conf iguring a SAN Archive
San Archives are configured in a similar way to NAS Archives. Before starting, check that the Vision2 server used to host the SAN
archive has permission to read/write from the SAN. Next map the SAN as a network drive on this server using the I drive (note
windows search is set on the I drive so do not use another drive letter). Follow the instructions for configuring a NAS Archive. Use
ArchiveService2SAN in all cases instead of ArchiveService2NAS and replace \\NAS\NASArchiveService with the name of the folder
to use on your SAN e.g. I:\vcContent\Archive1. Use an account that has read/write permissions on the SAN.

Conf iguring IIS for NAS/SAN Archives
Configure IIS for NAS Archive as follows:
1. Using IIS Manager select Connections > Sites > Default Web Site > v2, f ind a folder called Archives.
2. Right click the Archives Folder and select Add Virtual Directory.
3. In the Alias text box enter ArchiveService2NAS.
4. Set the PhysicalPath text box to the UNC Path to the folder on the NAS e.g \\NAS\NasArchiveService.
5. Click Connect as..
6. Select a Specific User and enter the domain\username of the NAS user account e.g. AMX\username.
7. Click Set.. and enter the username and password for the NAS user twice.
8. Click OK.
9. Now configure the V2AppPool to use the identity of the NAS user, Select Connections > Application Pools.
10. Right click the V2AppPool and select Advanced Settings.
11. In Process Model | Identity, select ApplicationPoolIdentity and click the [...] button.
12. Select a Custom Account and enter the domain\username of the NAS user account e.g. AMX\username and password for the

NAS User account.
13. Restart IIS.

Supported Video on Demand Media Formats
Archives can provide a Video on Demand service for five types of media files (WMV, MPEG-2, MPEG-4, Flash Video (FLV), and MP3).
When uploading a file into the archive, a bitrate setting (high, medium, or low) must be chosen. The following tables indicate what
setting users should choose for different file types.

NOTE: Due to Flash and browser security, if downloading videos in order to upload later into Vision2, please rename the extension of 
the f ile video.mpeg to video.ts.

Flash Video (FLV)
Flash video on the Vision2 server uses only standard definition and below video sizes. Flash videos must be encoded using the On2
VP6 video codec. The following table lists the recommended bitrates for flash video:

Windows Media Video (WMV)
Windows Media video can be encoded using WM9 and VC1. The following table lists the recommended bitrates for Windows Media
video:

The recommended bitrate for high-definition VC1 is 8-12 Mbits.

MPEG-2
MPEG-2 must be encapsulated in an MPEG-2 transport stream. The supported audio formats are:

MPEG Layer I
MPEG Layer II
MPEG Layer 3 (MP3)
AC3

Flash Video Recommended Bitrates
High Full D1 1.5 Mbits

Medium Full D1 800 Kbits

Low SIF 400 Kbits

Windows Media Video Recommended Bitrates
High Full D1 1.5 Mbits

Medium Full D1 800 Kbits

Low SIF 400 Kbits
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The following table lists the recommended bitrates for MPEG-2 video:

High-definition is supported for playback to a set-top box. The recommended bitrate is 8-12 Mbits.

 MPEG-4 AVC (H.264)
MPEG-4 files must be encapsulated in an MPEG-4 stream (.mp4). Files must have the MOOV Atom at the start of the file for fast
start. The audio must be in AAC format. The following table lists the recommended bitrates for MPEG-4 video.

NOTE: The bitrates specif ied above are for playback on a PC unless otherwise stated.

MP3
A bitrate setting is not required when uploading MP3 files as the bandwidth requirements are modest compared to video. All MP3
files are uploaded using high bitrate.

NOTE: Tablet users can only view and play MPEG 4 and MP3 f iles.
Set-top box users can only view and play MPEG 2 and MP3 f iles.

Video on Demand and Managing Content
All content is stored in the archive in a hierarchical structure, much like folders on a PC, and is displayed in a similar manner in the
archive service menu. The terms folder and category are interchangeable, similarly video refers to either video or audio files.
The Archive > Recent Updates page shows the 100 most recent updates in the selected archive. This page only shows published
videos. If the user is a non administrator and access control is enabled on this archive then they user will only see updates in
folders that they have been given view permission to by the system administrator. Select a video and click Open Containing
Category to show the category containing the selected video.
Choose Archives > Browse to view the list of archives configured in your system (FIG. 86).     

NOTE: Any account that is not an Administrator, will only see published videos when browsing an archive from a tablet or Set Top Box 
interface.

Double click an archive to view its contents (FIG. 87). Each archive has the following special folders which cannot be deleted:
DVR Recordings which contains videos recorded by continuous or scheduled record services.
A trashcan - This is a special folder which contains media deleted from the rest of the archive. Deleted videos are placed

here. To remove a video completely and free up hard drive space, users with appropriate permissions can delete the video
from the trashcan.

The content folder contains all the rest of the media in this archive. This is the most commonly used area of the archive.

MPEG-2 Video Recommended 
High Full D1 8 Mbits

Medium Full D1 6 Mbits

Low Full D1 4 Mbits

MPEG-4 Video Recommended Bitrates
High Full D1 1.5 Mbits

Medium Full D1 800 Kbits

Low SIF 400 Kbits

FIG. 86  List of Archives in a Vision2 System

FIG. 87  Special Folders (Content, DVR Recordings, Trashcan)
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Click once on a folder to see its description. See FIG. 88 for an example.     

Folders images (thumbnails) are taken from the thumbnail of the most recent media uploaded in that folder or its subfolders. If
there is no media in the folder or its subfolders, a standard folder icon is used instead. Double click a folder to look inside. The
Archive path (FIG. 89) shown just beneath the menu bar updates. The archive path contains a number of segments. Click a segment
to jump to that level in the archive. Click the segment that is the furthest to the right to refresh the display and show any updates to
the folder. This is useful if another user has added a new media file to the folder.

Folders can contain media files (audio/video) or folders but unlike windows you cannot combine folders and files. Videos are shown
with thumbnail (a screenshot) taken from the video and a small filmstrip icon in the bottom left corner. You can alter this thumbnail
image if required using the Edit Poster Frame feature, see Edit Poster Frame  on page 64 for more details.
The options drop down menu (FIG. 90) shows what tasks are available, these options change depending on where you are in the
archive and what you are doing. The following options are available when you enter a folder:

Search Archive - search the whole archive for media files whose name or metadata match text entered by the user. Note
you do not have to enter the full text, you can use wildcards. The * and ? wildcards are supported. For example searching
for film* will f ind film1 and film2 and films. Searching for film? will f ind film1 and film2. Search Archive is case insensitive
so FILM* will return the same result as film. Select one of the matching videos and click Open Containing Category to jump
to the category containing the video.

Create New Category - create folder. Files and folders cannot be mixed in a folder. Trying to create a folder in a category
which already contains files, Vision2 will prompt you to move the files that are currently in the folder to a new folder.

Edit Category - change folder name and description of the selected folder.
Delete - Note you can only delete a folder if it does not contain any files. You cannot delete multiple folders.
Cut - Cut and paste a folder. Folders can only be pasted into a folder which does not contain any files.
Upload New Media - Upload a new video/audio file to the folder, see the Upload Video  on page 63 for more details.
Sort Media by Name - Sort videos alphabetically by name.
Sort Media by Date - Sort videos by date and time uploaded.

FIG. 88  Folder with Description

FIG. 89  Archive Path

FIG. 90  Options Menu

Thumbnail taken from last video uploaded in this folder
or any sub-folders of this folder
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Now that you are in a folder, click on a video/audio file to select it. The selected media is shown with a light blue border. If the media
has metadata, then the information in the first metadata section is shown. Typically this is the video synopsis (FIG. 91). To select
multiple media files, use CTRL-click. To select a range of media, use the SHIFT key. The only option available on multiple media files
is delete.

The following operations are available in the options drop down menu when you select a video:
Rename Media - Rename the media file.
Create Shortcut - Create shortcut to media file, this acts like a copy of the media. Then cut and paste a shortcut to another

location.
Publish/Hide - change whether media is published/hidden. Published media is viewable by Tablet and set-top box users. If

user access control is enabled for this archive then Published media is viewable by Set-top box, tablet, or PC users with
view permission to this folder.

NOTE:  If access control is enabled for a particular archive, then PC Users without Publish permission cannot see Hidden media. See 
Archive Permissions on page 23 for more details. 

Cut/Paste - Cut a video and then paste it to another location. Only one video at a time can be cut/pasted.
 Delete - Delete selected media files to the trashcan. If in the trashcan, there is a delete option which deletes the media

permanently and frees up space on the drive.
Sort Media by Date - Sort media by the date/time they were uploaded to the system.
Sort Media by Name - Sort media by name.

Playing Video
Double click on a video to play it. Vision2 automatically selects the best format and bitrate if there multiple formats and bitrate
versions of this file. The following operations are available in the options drop down menu while playing a video:

Edit Information - Edit Video Metadata.
Upload Additional Media - Upload an additional version of the video in a different bitrate or format. This process is similar

to uploading a new video, see the section on Uploading a Video below.
Edit Poster Frame - Edit video thumbnail.

Upload Video
To upload a video, select Upload New Media from the options menu to display the upload screen (FIG. 92). Vision2 does not support
transcoding files. Versions of the same file must be uploaded with different formats and bitrates using the Upload Additional Media
option. 

Perform these steps to upload a video:
1. Click the Browse (...) button to select a file to upload.
2. Select a Bitrate for the video from the drop down. The available options are high, medium, and low. This option is not available

for MP3 files as bitrate is irrelevant in this case the bandwidth demands of MP3 files are relatively low.
3. Enter a name for the video in the name text box, by default the name is taken from the filename. Note this text box is not

available if you are uploading an additional video. Punctuation is not accepted, only numbers or letters are allowed.

FIG. 91  Video with Thumbnail + First Metadata Section (Typically Synopsis)

FIG. 92  Upload Media

Media file 

Duration of Media

Media Thumbnail
can be modified using
Edit Poster Frame

Published State

First metadata section
typically synopsis

Media Name

Filmstrip indicates this 
is a media file
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4. Set the publish check box to change whether the uploaded video is published/hidden. This check box is not available if
uploading an additional video. Published videos are viewable by Tablet and Set-top box users. If user access control is enabled
for this archive, then Published videos are viewable by Set-top box users if their user group has view permissions on this
folder. Published videos are viewable by PC and tablet users if the user group they belong to has view permission to this folder. 

NOTE:  If access control is enabled, then only Admin Tablet or PC users with Publish Media permissions will be able to view hidden 
media. Standard Tablet and Set-Top box users will never see hidden videos even if Publish Media permissions have been set for their 
user group. See Archive Permissions on page 23 for more details.

5. Click Upload to begin uploading the video. This process can take some time, especially with large video files.

NOTE: This upload tool has a limit of 2GB. If needing to upload larger f iles, use the AMX Vision2 FTP client.

Edit Poster Frame
Use this option to edit the thumbnail image for the video in the Archive. Click Update Poster Frame to take a snapshot of the
playing video and use this as the video thumbnail to identify the video in the archive.
Select Options > Cancel/Done editing to finish.

NOTE:  The snapshot captured by update poster frame is taken from the nearest previous I frame to the point at which Update Poster 
Frame was clicked. This may be slightly out of sync with the video playback.

Layout Menu
The layout menu allows you to select the layout used for browsing the Archive. There are three options:

Tiles - default layout
Tiles + Navigation Tree - default layout + windows explorer style tree navigation pane on the left of the screen
List + Navigation Tree - list view + windows explorer style tree navigation pane on the left of the screen

View Menu
The view menu allows playback of different bitrate versions of the selected video (FIG. 93). The best available video format is
selected automatically. If logged in as an administrator or user with upload permission in the current folder, use the details drop
down to select any of the available file formats and bitrates to check all versions of the video play correctly.

The format is chosen automatically. If wanting to play a particular format and bitrate, use the details menu (this option is only
available to administrators or those with upload permission).

Playing a Video within the Archive
To play a video within the archive double click the Video thumbnail. The highest bitrate and best available format begins to play
(FIG. 94). 

FIG. 93  View Menu

FIG. 94  Select Video to Playback (Selected Video is Shown with a Light Blue Border
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The column on the right of video playback area shows video codec information and metadata such as synopsis, credits, etc
(FIG. 95). By default videos do not have any metadata. Codec and bitrate information is only shown to administrators or users with
upload permission to the folder containing the selected video. To play a different version of the video, use the Details drop down to
select the format and bitrate to play. Again this is only available to administrators or those with upload permission. Normal users
can use the View menu to select a different bitrate version of the video. The format is chosen automatically. Click Go Fullscreen in
the View menu to view the video fullscreen.   

NOTE: Audio content cannot be played from the Archive service on the server itself since the server has no audio capability. Audio 
f iles must be played from a remote browser with audio capabilities.

Editing Metadata
To edit metadata for your media, start playing a video and select Edit Information from the options drop down menu.

To edit metadata, carry out the following:
1. Add a metadata section or select an existing metadata section.
2. Edit the metadata section contents.
To add a metadata section, select Add New Section and choose an appropriate section from the drop down menu (FIG. 96). Click
Apply. If there is no suitable metadata section, create a new one by following the instructions in the Video on Demand and
Managing Content  on page 61. 

FIG. 95  Video Playback with Codec Information (Only Shown to Administrators or Users with Upload Permission)

Metadata Options 
Add New Section Add new metadata section to video.

Delete New Section Delete selected metadata section (only available when
selecting a metadata section heading).

Save Information Save changes to metadata.

Move Section Up Move selected metadata section up one in the list (only
available when you select a metadata section heading).

Move Section
Down

Move selected metadata section down one in the list (only
available when you select a metadata section heading).

Cancel/Done Editing Exit metadata editing.

FIG. 96  Select New Section to Add to Metadata
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The new metadata section will now appear in the metadata column.
To edit the contents of a metadata section click underneath the relevant section heading (FIG. 97). A blue border appears. Edit or
enter text in the space provided.

Archive Permissions
The Archive Permissions Screen Archives > Archive Permissions is used to control user and set-top box access to Archives and the
folders contained within Archives. By default User Access is disabled for an Archive. This means that any user can carry out any
operation on the archive and its contents. To control access to an Archive proceed as follows:
1. Choose the Archive to restrict from the Select a Service drop down and click Load.
2. Change the Archive User Access Control setting from No to Yes and click Apply. Now Access Control has been enabled for an

Archive. No users can access content in that Archive.
3. To give users access to a folder, expand the User Groups heading in the User Groups column and choose a User Group.
4. Expand the Archive and folder to give access to in the Archive Contents column such as the Content folder.
5. Drag the chosen user group and drop it under the folder where you see the text Drop a user group here. The Permission

column is now enabled. This column shows all permissions available to this user group on this folder. The available permissions
are show in the Archive Permissions table.

Enable the permissions required and click Apply. To remove this user group and revoke all its permissions click Remove.
There is a special user group called AMX-STB-VIRTUAL-USERGROUP which controls access for set-top box users, this is shown in
blue. This group only has one permission, the View permission, as set-top boxes are unable to carry out any other actions on
Archive contents. To allow set-top box users to view published MPEG2 or MP3 media in a particular folder, give the AMX-STB-
VIRTUAL-USERGROUP view permission on that folder.

NOTE: To update set-top-box permissions, navigate away from the main menu on the set-top box using the set-top box controller. 
Press and hold the menu button to update Archive Permission changes.

FIG. 97  Editing Metadata Section Contents

Archive Permissions
Permission Description

Manage Category This permission allows the following tasks:
• Create a category inside this category.
• Edit category description and name.
• Delete media files in this category.
• Cut/paste files/folders to/from this category.
• Create shortcut to video in this category.

Delete Category Delete category (if empty).

View Media View and play Media files in this category. Without this permission you cannot view
the category at all.

NOTE: Any account that is not an Administrator, will only see published videos when 
browsing an archive from a tablet or Set Top Box interface

Upload Media Upload Media to this category.

Edit Media • Rename Media.
• Edit media metadata.

Edit Poster Frame Update video thumbnail (note the thumbnail that is captured may be out of sync
with the video due to technical limitations).

Download Media Download media to user’s machine. Internet Explorer smart screen filter will need
to be disabled.

NOTE: Due to Flash and browser security, if downloading videos in order to upload 
later into Vision2, please rename the extension of the f ile video.mpeg to video.ts.

Publish Media View unpublished Media and change the publish state of Media from Publish to
Hidden and vice versa. Published media can be viewed and played by Set-Top Box
users who have view permissions on an folder and any other users with View
permission. Hidden media is only viewable by PC users with Publish Media
permissions or Admin Tablet users. Standard Tablet and Set-Top box users, will
never see hidden videos even if Publish Media permissions have been set for their
user group.

Click heading to select

Click under heading to start editing
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NOTE: Updates to Archive Permissions/changes to Archive will not appear until tablet users re-login. PC users need only re-enter an 
archive folder to refresh Permissions.

Permissions set on a category do not automatically apply to sub-categories of that folder. The permissions must be set individually
on each sub category. The only exception to this rule is the DVR Recordings category. Permissions set on the DVR Recordings
category apply to all categories created in this folder by Record services.

Conf iguring Metadata
When selecting Archives > Conf igure Metadata, the following page appears (FIG. 98).

The Archive supports two styles of metadata:
Built-in: This type of metadata cannot be modified.
Normal: This information is available in both management and user interfaces.

The built-in metadata is used to display the available formats of specific videos and technical information about the videos.
Metadata is stored in different sections which appear in the information bar when playing a video in the archive. User-created
metadata sections can be of one of two types:

Text Section: Sequential text.
Table Section: A table with a user defined number of columns.

Creating a New Metadata Section
To create a new text section, click Add new Text section. The following options appear:

To create a new table section, click Add new Table section. Select the number of rows and columns, and click Add Table.

FIG. 98  Metadata Configuration

Add New Text Section Options
Section Name This is the name of the section as it appears on the left side of the page. It can be

different to the Displayed Name so that related sections appear together in the
lists. For example:
• Music Video: Info
• Music Video: Credits
• Music Video: Lyrics
• TV Program: Credits
• TV Program: Synopsis

Displayed Name This is the name of the section as it will be displayed to users.

Add New Table Section Options
Section Name This is the name of the section as it appears on the left side of the page and also

when editing metadata in the archive. It can be different to the Displayed Name so
that related sections appear together in the lists. For example:
• Music Video: Info
• Music Video: Credits
• Music Video: Lyrics
• TV Program: Credits
• TV Program: Synopsis

Displayed Name This is the name of the section as it will be displayed to a user.

Edit Table

Insert Column Insert an extra column.

Delete Column Delete the selected column.

Insert Row Insert a new row.
67Vision2 Instruction Manual



Archive Service
If desired, insert text into the table as a hint for when someone is adding metadata to a video. FIG. 99 displays a new table based
section and the hints.  

IMPORTANT: Click the Save Changes button to save any changes that need to be kept.

 

FTP Client
Vision2 includes an FTP Upload tool to allow users to upload files that are bigger than 2GB. The standard Archive upload option
does not work with files of this size. Download the FTP Client as follows:
1. Go to Archives > Download FTP client.
2. Click the link to download ADOBE AIR.
3. Click Download now and then run to install AIR.
4. Click the download link above the Vision2 logo to download the Vision2 FTP client.

Use the FTP client to upload files as follows:
1. Click Open in the Internet explorer download window to run the application.
2. Enter your Vision2 user name and password and the name of your Vision2 master server (FIG. 100).

3. Click Login.

Delete Row Delete the selected row.

Width Define the width of the selected column.

FIG. 99  Metadata Table

FIG. 100  Login Screen for FTP Client

Add New Table Section Options
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4. Select the archive to upload to from the Select an Archive drop down menu (FIG. 101).

5. Click load now.
6. Use the upload files section to select a file to upload, the file path to the right of the icons shows the current location.
7. Click the up arrow to navigate up the folder hierarchy, click refresh to see any changes to the folder. Click the folder icon to

jump to the my documents folder. Click the screen icon to jump to the desktop.
8. Double click on a filename in the file table to select that file.
9. Choose a bitrate for the file.
10. Chose a name for the file. The name is taken from the filename by default. Punctuation is not allowed, only letters or numbers.
11. Set or clear published check box as required.
12. Click the basket with the plus icon to add this file to the upload basket.
13. Repeat steps 6-12 for each file to upload.
14. Using the bottom section of the window, expand the archive tree and select a category in the archive into which to upload the

files in the basket.
15. Click upload basket to see a list of the files to upload (FIG. 102).    

16. Click Upload to upload the files in the basket to the archive.

FIG. 101  FTP Upload Client Main Window

FIG. 102  Upload Files Basket showing List of Files to Upload

Category to upload to.
Select Category to upload to.

Add selected file to Upload Basket.

View Upload Basket and Upload selected files.

Load selected Archive.
Choose archive to

Path to Files shown in 
table below.

File name of selected file
Select Bitrate for file.
Enter name to use for file
in Vision2 Archive. No 
punctuation, only letters
and numbers.

File table, select a file
to upload here.

Choose whether file is
published or not.

FTP Upload Client log

upload to.
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Producer Service
Overview
The Vision2 Producer Services enables users to create a scheduled TV channel. Users can schedule the Producer to display either 
MPEG 2 Live Channels or MPEG-2 or MP4 H.264 files from a Vision2 archive. Schedules run on a four week loop, then begin again 
after the four weeks have expired. In the event there is no content scheduled for a certain period of time, Producer enables setting 
an intermission source which automatically plays either a MPEG-2, MP4 H.264file from a Vision2 archive or an MPEG-2 Live 
Channel.

NOTE: A Producer service can only use Archives on the same server as the Producer service or on a NAS.

NOTE: Some MP4 f iles may not be compatible with the Vision2 Producer Service. They may play when accessed via Video on Demand 
but when used by the Producer and accessed as a live channel on the client they will not play, or will only play audio. If you see these 
symptoms then the f ile must be re-encoded and uploaded to the Vision2 archive again replacing the defective f ile.

NOTE: The Producer service cannot display HD h.264 Live Channels.

Producer Channel Best Practices 
When creating producer channels, consider the following best practices for best playback results: 

Always use content with the same codec.
Avoid mixing SD and HD content. Some playback devices (including Enzo), will playback content based on the resolution of 

the initial video received, and then scale all other video content to match.
The video bitrates of content in the producer channel should be similar.

Conf iguration
Access the Producer page using Producers > Manage Producers (FIG. 103).

The following options can be configured for the Vision2 Producer Service:

FIG. 103  Producer Configuration Page

Conf igure Options
Video Format Select the Video format from MPEG or MP4 h264. Only files of this format are 

shown when you select a file for intermission or to add to the Producer schedule.

Intermission Bitrate Select the Bitrate from High, Medium, or Low. Only files with matching Bitrate and 
Format are shown when selecting a file for intermission or adding to the Producer 
schedule.

Destination

Address The multicast address for the Producer channel.

Continued 
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NOTE: If conf iguring a f irewall on a Vision2 server, incoming multicasts must be permitted.

Setting Up an Intermission
If there is no content scheduled for a certain period of time, Producer enables setting an intermission source which automatically 
plays:

MPEG-2 or MPEG 4 h264 file from a Vision2 archive.
Multicast MPEG-2 source such as a DVB or Live MPEG channel.
Unmanaged Live channels are also available for Intermission as well. 

Perform these steps to set up an intermission:
1. Set the File or Live Feed options to indicate whether the intermission source is from a file or live feed. After making your 

selection, do one of the following:
File: Select an Archive using the Content drop down menu. Select a file using the Name drop down.
Live Feed: Select a live channel from the Live drop down menu.

2. Click Apply.
3. Set the Enable Intermission setting to ON in the Intermission section and click Apply.
4. Set the Stream Enable setting to ON to activate the Producer.
The Name and URL text boxes populate with the name and path of the intermission source. This source will play if there is no 
scheduled content.

Viewing the Stream
Enable the Stream and click the Watch icon. Some content must be scheduled or an intermission source enabled, otherwise nothing 
will be seen.

Port The multicast port for the channel.

TTL The multicast TTL for this channel. Enter a value in the space provided.

NIC The IP address of the network to use for multicasting.

Intermission

This section defines what to do if there are no videos scheduled to broadcast. Users can schedule a specific MPEG-2 
file from a Vision2 archive or a multicast MPEG-2 source such as a DVB or Live MPEG channel.

Intermission Enable Use this setting to enable/disable the Intermission. If the Intermission is not 
enabled and nothing is scheduled, the user sees a blank screen.

Source Defines whether to use a file playing in a loop or a live feed during Intermissions 
between scheduled content.

Live (Live Feed only) Select the live channel from the available list. This option only appears if you select 
Live Feed for your source.

   Content (File only) The Archive which is to be used as the source of the videos to be scheduled.

Name (File only) Select the file matching the format and bitrate selected to use as the intermission 
source.

URL This value is read only and shows the path to the file or Live Channel as 
appropriate.

Conf igure Options
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Schedule Editing
Producer runs a four week schedule which loops every four weeks (Week A, Week B, Week C, Week D, and back to Week A again). To 
edit the schedule, click the Edit button next to Service Schedule in the Producer screen. Alternatively go to Producer > Edit 
Schedule, select the Producer to edit, and click Load (FIG. 104). 

The main scheduling options are as follows:
To schedule a new program – Select an Archive from the Archive Sources drop down. Expand the archive to locate the file to 

add. Only published files of the chosen format and bitrate are displayed. If access control is enabled for this Archive then 
non administrator users will only see published files of the correct format and bitrate in folders that they have view 
permission access rights to. Drag the file onto the schedule.

To move a program within the schedule – Click on the program and drag-and-drop it into the new location. If attempting to 
drop it to a location where it will not fit (due to other programs) then it will return to its original location.

To schedule a Live channel – Choose the Live channel to display from the Live Feed Sources drop down. Expand the chosen 
Live channel and select the length of time for this channel to display, The following durations are available: 15, 30, 45, and 
60 minutes. Drag the chosen live channel onto the schedule.

To remove something from the schedule, drag and drop it onto the trashcan.
Click Save Changes once the correct schedule has been set. Click Go Back to return to the previous screen.

NOTE: When a Producer service is enabled, if it has missed the start time for a scheduled item (live channel or archive f ile), this item 
will be ignored and the next item in the schedule which has a start later than the current time will be played.

FIG. 104  Edit Schedule Screen

Edit Schedule Options
Zoom setting, represented by a 
magnifying glass

Click the + symbol to zoom in.
Click the - symbol to zoom out.
Drag the slider left/right to zoom out/in.

Copy Click Multi Copy/Delete to access this option. The copy option enables copying 
individual programs, days, or entire weeks from one part of the schedule to 
another.

Delete Click Multi Copy/Delete to access this option.The delete option enables deleting 
individual programs, days, or entire weeks from the schedule.

Save changes To update the schedule on the server, click Save changes. Any changes will 
immediately take effect.

Show Video Info Show video thumbnail and information about video.
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Record Service
The Vision2 Record Service provides the ability to record an MPEG-2 Live Channel into an Archive either continuously creating files 
of a fixed duration, or manually recording a specific event. Alternatively, recordings can be scheduled to happen at particular times 
and dates.

NOTE: If recording to an archive on a drive with less than 40GB space, Vision2 will refuse to enable the record service until this issue 
is resolved. If drive space falls below this limit while recording is taking place, the service will continue to write to the disk until all disk 
space is consumed. A warning will be received when a record service is enabled if the drive space is less than 150GB. The amount of 
space remaining can be viewed on the drive in the Archive > Conf igure Archive screen.

The record service has the following limitations:
Continuous and manual records under 1 minute in duration are not saved.
The Record service can only use Archives on the same server as the Record service or on a NAS.
The Record service needs an audio track to function correctly. If recording a CCTV camera, audio on the camera will need 

to be enabled to create an audio track even if there is no microphone on the camera.
Producer channels can not be recorded.

Conf iguration
The following page appears (FIG. 105)when Video Recorders > Conf igure Recorder is selected:

NOTE: Once recording is enabled, recording parameters cannot be changed.

The following settings are available in the Recording section:

FIG. 105  Configure Record Service

Recording Settings Options
NIC The IP address of the Network interface card from which to record. If the Live 

Channel you wish record is multicast on a different NIC, this setting will need to 
change.

Recording type This can be either Continuous, Manual, or Scheduled. Continuous recordings 
create a new recording in the Archive at specific intervals according to the value 
defined in the Segment length option. Manual recordings require the user to 
actually start and stop the recording process themselves.

Segment length This value defines the length of each continuous recording. Available options are 
15, 30, and 60 minutes.
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Recording a Video Stream
Perform these steps to record a video stream:
1. Select the IP address from the NIC drop down menu of the network the Live Channel is multicast on.
2. Select Continuous from the Recording type drop down.
3. Select the length of each individual recording from the Segment length options menu.
4. Use the Keep Archives for spin box to indicate how long for the recordings to remain in the archive.
5. Click Apply to save the new settings.
6. Change the Service Enable setting to Yes and click Apply to start recording the video stream. Recordings are placed in a folder 

with the same name as the Record Service inside the DVR Recordings folder.
7. Change the Service Enable setting to No and click Apply to stop recording.

NOTE: If a f irewall on a Vision2 servers is conf igured, incoming multicasts must be permitted.

NOTE: If the hard disk hosting an archive becomes full while recording, any record service which is conf igured to write to that archive 
will stop recording, however, they will still show as enabled in the Vision2 user interface. The relevant record services will need to 
disabled and re-enabled to continue recording once space is cleared on the disk. This applies to Manual, Continuous, and Scheduled 
Record services.

Manual Recording
Configure the Record Service in the same way as for a Continuous Record, except choose Manual Record from the Recording Type 
drop down. After the Record service has been configured for manual recording and the service enabled, a Manual Record section 
appears. Click open to enter the Manual Record Screen. Alternatively, go to Video Recorders > Manual Recording and select and 
load the Manual Record Service to use.

NOTE: The f ile name is not the name of the f ile that will be recorded, but it is the name of the recording as displayed in the archive.

Keep Archives for To prevent the continuous recording mode from filling up the hard disk used by the 
archive, the system will automatically delete generated recordings after the 
number of days specified here. To prevent specific recordings from being deleted, 
cut the video from the relevant sub-folder within the DVR Recordings folder and 
paste into the main archive.

Write to Archive This defines the archive in which you want the recordings to save. Note that you 
can only record to Archives on the same server as the Record service or to NAS 
archives.
All automatic recordings are placed in a special area of the archive called DVR 
Recordings.

Record From This enables you to select which Live Channel to record.

Recording Settings Options

FIG. 106  Manual Record Screen

Duration Start Recording 

Stop Recording 
 

Folder in which to save Recording Name for Recording

Channel Name

Live Channel to Record
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Record a video as follows:
1. Enter a name for the recording in the Name text box.
2. Select a category (folder) to record to.
3. Click Start. Once a Manual Record is started, you cannot leave this screen until stopping the Record. If performing more than 

one Manual Record at a time, login with a separate Browser tab.

NOTE: You cannot record longer than 180 minutes.

4. Click Stop to end the recording and save a copy of the recording to the archive.

Scheduled Recording
The Scheduled Record feature enables scheduling when to record a MPEG 2 Live Channel. Configure the Record Service in the same 
way as for a Continuous Record, except choose Scheduled Record from the Recording Type drop down. After configuring the 
Record service for scheduled recording and enabling the service, a Schedule section appears at the bottom of the screen. Click Edit 
to enter the Schedule Screen. Alternatively, go to Video Recorders > Scheduled Recording and select and load the Scheduled 
Record Service to use.

Edit the Record Schedule as follows:
1. In the Schedule editor click the calendar icon and select the date when the recording should occur. (FIG. 107).

NOTE: A red horizontal line shows the current time. Click Show Now to jump to the current time.

2. Move the cursor over the schedule to select the time (24 hour clock) where the recording should occur and click at this 
selection. Up/down cursor keys may be used. A pop-up dialog box appears (FIG. 108).

Manual Record Options
Name Name for the video to record in the archive.

Select Category Select category to record to. Vision2 will prevent selecting a category which contains other 
categories. An empty category or one which contains media files must be selected.

Start Start Recording.

Stop Stop Recording. Note: Recordings which are shorter than 1 minute are discarded.

FIG. 107  Schedule Editor for Record Service

FIG. 108  Scheduled Recording Dialog Box
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3. Enter the name for the recording in the Program Name text box.
4. Use the up-and-down arrows to change the duration of the recording in 10 minute increments up to a maximum of 180 

minutes.

NOTE: A value in the Duration text box can be entered, however, Vision2 only supports scheduled recordings in 10 minute increments. 
If a value in the Duration text box is entered that isn't a 10 minute increment, Vision2 automatically rounds up to the next 10 minute 
increment without alerting you.

5. Click Add. A new recording is then displayed in the schedule.
6. Click Save Changes to save the updated schedule. Any recordings created are placed in a folder with the same name as the 

Record service inside the DVR Recordings folder.

NOTE: If a Record Service is disabled and re-enabled while a scheduled record is in progress for that service, that scheduled record 
will not resume.
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Appendix A: Graceful Startup/Shutdown Procedure
Overview
In the event of a planned or unplanned network or electrical outage, the following steps should be taken to ensure a controlled 
shutdown and restart of the IPTV system. The order of restart is critical to provide data to the control components as to last 
operating configuration. If the system is brought back into service randomly or in improper order, it may perform with unexpected 
behaviors.

Shutdown
The order of shutdown is not as critical as the restarting, but the recommended order and tasks are:
1. Slave servers - gracefully shutdown using keyboard and mouse attached to server (FIG. 109). 

To login, enter the username Administrator, and the default password Vision2. 
From the Windows desktop, navigate to Start and select Shut Down. 

2. DTV-MA01 TDS Management Appliance- gracefully shutdown using keyboard and mouse attached to unit. 
To login, enter the username amxdtv, and the password admin.
From Windows desktop, navigate to Start and select Shut Down. 
As an alternative, press and hold the power button on the front face of the unit until activity and power indicator lights turn off 
(FIG. 110).

3. DTV-TX03 Transmitter - power off unit by disconnecting power cable from rear of unit (FIG. 111). 

4. STB-04 Vision2 Set-Top Box - power off unit by disconnecting power cable from rear of unit (FIG. 112). 

NOTE: In the event of a planned network or power outage it may not be necessary to power down every Amino throughout the facility, 
but it is a recommended practice. When network and power are restored, it may be necessary to select a program to be played on 
each Amino. This can be accomplished by using the hand-held Amino remote, or through the Vision2 UI in the Manage System > 
Manage STB screens.

When all systems are down, you can safely proceed without negatively impacting the operation of the IPTV system. Once complete, 
the information which follows will provide the recommended startup procedure to return the system to operation.

FIG. 109  Attach a Keyboard and Mouse to the Server

FIG. 110  DTV-MA01 - Front Panel Power Button

FIG. 111  TDS-TX03 - Rear Panel Power Connector

FIG. 112  STB-04 - Rear Panel Power Connector
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Startup/Restart
The order of startup is critical to the proper operation of the IPTV system following a network or power outage. Several of the 
system components provide configuration or status details to each other, and the absence of that information can cause 
components to malfunction. 
A short wait period between powering up each device is recommended to ensure that each has a chance to initialize before the next 
to provide any needed configuration or status data in the proper sequence.
In addition, if the network has been offline during an outage, the first requirement before bringing the IPTV system back into 
service is to ensure the network switches are in operation. 
If the servers or management appliances come online without network present, they may default to local loop-back addressing 
which would impair or stop necessary services within those devices.
The recommended order for restoration of the system components, and their tasks is:
1. Switch on network switches, routers and any other network infrastructure (e.g. DNS servers).
2. Switch on TV Headend RF/Cable/Satellite.
3. DTV-TX03 Transmitters - connect the power cord to the transmitters. Verify power and network connectivity by looking at the 

lights on the network interface at the rear of the unit.
4. DTV-MA01 TDS Management Appliance - press the power button on the front face until the power and activity lights 

illuminate and flash. Verify network connectivity by looking at the indicator lights on network interface at the rear of the unit.

IMPORTANT:IMPORTANT! - Restarting the DTV-MA01 causes it to beacon out to all attached Transmitters. These units will then 
respond back to the DTV-MA01 and will re-create the list of units found, refreshing the list of channels and re-sending requests 
to transmitters to stream the requested channels.

5. V2 Master Server - The master server must be fully started and online. Check that the Vision2 Server and VLC Server 
applications are up and running.

6. Check that all slave servers are up and running. Check that the Vision2 Server and VLC Server application are up and running.
7. STB-04 Vision2 Set-Top Box - Connect the power cord to the Set-top box. Verify power and network connectivity by looking at 

the lights on network interface at the rear of the unit. 
If the "unable to load web page" message appears on screen, place the unit into standby using the amino remote control. 
Press STB then the power button, wait a few seconds then press the power button again and ensure that the correct web page 
is loaded.

NOTE: STB devices that send an "offline" status to Vision2 will appear as offline in the STB table and the icon will turn gray.

Troubleshooting
In the case that this procedure is followed, but does not return the system to functionality, there are several steps which may be 
performed to verify which portion(s) of the system is not operating properly. For purposes of this document, these steps are 
bulleted, with more detailed information referenced.

No TV signal on screen
Verify that the display is connected to power and to the STB-04.
Verify that the display is powered on.
Verify that the STB-04 is connected to power, network, and to the video display.
Verify that the STB-04 is powered on by checking the red LED on the front of the STB-04.
Verify that the STB-04 has network connectivity by checking connectivity and activity lights on the rear of the unit.
Verify that the correct video display input is selected (check video connection from STB-04).
Verify that the STB-04 has a proper IP address and that the default browser page is configured.

No TV signal from Transmitter
Verify that network switch is operational, and that connectivity/activity lights are illuminated and flashing.
Verify that CATV connection/service is functioning, and that transmitters have power, coaxial (RF), and network 

connections.
Verify that transmitters are powered on, or that power source (strip/UPS, etc) is working.
Verify that transmitters have active network connections with network activity lights on the NIC illuminated and flashing.
Verify that the transmitter is configured and has a saved channel list (refer to the AMX TDS Television Distribution System 

Operation/Reference Guide for details on transmitter configuration).
Beyond these simple checks, the configuration of the V2 TDS gateway and the DTV-MA01 may need to be verified. For additional 
details, consult the Operation Reference guides for these products, available at www.amx.com, or contact AMX Technical Support.
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Backup Procedure
1. Backup all NAS folders containing Archive content.
2. Carry out the following on each Vision2 server:

a.  Backup folders H:\vcContent, C:\inetpub\wwwroot, C:\ProgramData\AMX\Licensing.
b.  Backup the three Vision2 databases:
BandwidthDatabase
EventStore-V2
ReadModel-V2

Database Backup Procedure
The database backup procedure is as follows:
1. Launch pgAdmin III. The username is postgres and the default password is Vision2. 
2. In Object browser expand the Server Groups tree to find Databases.
3. Expand Databases and select each of three databases listed above in turn.
4. Right click and select backup.
5. Click the... button on the same line as filename to select a folder for backups. Name the backup files with the name of the 

database and date of backup.
6. Select Format Tar.
7. Set Encoding to UTF-8.
8. Set Rolename to postgres.
9. Click Backup.
10. Repeat steps 3-9 for each of the three databases.

Restore Procedure
Restore backed up NAS folders.
Restore the backed-up folders H:\vcContent, C:\inetpub\wwwroot and C:\ProgramData\AMX\LicensingOn each Vision2 server, 
then restore the three databases as follows:
1. Launch pgAdmin III, the username is postgres and the default password is Vision2.
2. In Object browser expand the Server Groups tree to find Databases.
3. Expand Databases and select each of three databases listed above in turn.
4. Right click and select restore.
5. Click the... button on the same line as filename to select the folder containing backups. Select Format Tar.
6. Set Rolename to postgres.
7. Click Restore.
8. Repeat steps 3-7 for each of the three databases.
9.
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Time Zone Issue
Postgres datestyle MUST be configured to the same datetime zone on all Vision2 servers. 
1. Open C:\Program Files (x86)\PostgreSQL\9.2\data\postgresql.conf file on each server and look for "datestyle" attribute. 
2. Set it as datestyle = 'iso, mdy' for US date format, or datestyle = 'iso, dmy' for European date format.



Appendix D - Upgrade Processes
Appendix D - Upgrade Processes
Upgrading the Vision2 Software
Periodic upgrades will occasionally be available for the Vision2 interface. Upgrades are available by contacting AMX Tech Support at 
800-932-6993. 

NOTE: Before upgrading, it is recommended that you make a copy of the server for backup purposes. Refer to Backup Procedure  on 
page 79.

NOTE: Upgrade installations must be performed using the built-in Vision2 “administrator” account.

Post Upgrade
Perform the following steps after upgrading your Vision2 system:

Change Recycling Conditions Settings
1. Open Start > Administrative Tools > IIS Manager and select Application pools.
2. Right click V2AppPool and select "Recycling" (FIG. 113). 

3. Uncheck "Regular time intervals (in minutes).
4. Check "Specific Times" and enter 3:00 AM.
5. Click the next button.
6. Click the Finish button.

Change Disable Overlapped Recycle Settings
1. Right the V2AppPool again.
2. Select "Advanced Settings".

FIG. 113  Application Pool Recycling Settings
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3. Scroll down to the Recycling section (FIG. 114).

4. Click on "Disable Overlapped Recycle" setting.
5. From the drop down change from False to True.
6. Click OK and close the dialog.

Change Start Up Type
Due to the booting sequence of services, the Vision2 Network Monitor service Startup Type needs to be delayed until the NICs 
become available. If this is not done, the wrong NIC will be used which means the data recorded on network usage will be wrong.
1. On the desktop click Start > Run.
2. On the open field type services.msc and then click OK. Select the AMX Vision2 Network Monitor Service (FIG. 115). 

FIG. 114  V2AppPool Advanced Settings

FIG. 115  AMX Vision2 Network Monitor Service Menu 
82Vision2 Instruction Manual



Appendix D - Upgrade Processes
3. Select the Startup type drop down and pick 'Automatic (Delayed Start) (FIG. 116). 

4. Press OK.
5. Restart service.

FIG. 116  AMX Vision2 Network Monitor Service Properties - General
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